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e Hyphenation * Kerning
e Text Runarounds  Word Processing and More!



DOES NOI
LIVE BY
HELVETI

TIMES ROMAN
ALONE.

Sometimes it takes the drama of Benguiat Right on the spot.

to get the message across. Or the immediacy Let your POSTSCRIPT printer start doing

of American Typewriter. Or the authority of the whole job for you. Ask your Apple Laser

Bookman Bold. Writer dealer about the Adobe Type Library
So why limit your LaserWriter® or today. Or call us directly at 415-852-0271.

PosTScCRIPT® printer to standard Helvetica P.S. Also ask your dealer about

and Times Roman® POSTSCRIPT, Adobe Systems’ internationally

Today, Adobe Systems’ Type Library of recognized page description language.
fers you a veritable feast of type styles which

have been licensed from the world famous A sampling from the Adobe Type Library:
libraries of Mergenthaler and International ITC American Typewriter?® [TC Avant Garde
Typeface Corporation. With versions in Gothic® ITC Benguiat® ITC Bookman.” Friz
regular, italic, bold and beold italic. Over 45 Quadrata. ITC Garamond® Glypha® ITC Lubalin
classic styles in all—and more to come. Graph® ITC MACHINE® New Century Schoolbook.

Adobe type styles let you produce profes- Optima® Palatino® [TC
sional quality newsletters, direct mail pieces,  Souvenir® FIC Zapf Chanceny:

client presentations and ads just like this one. [ITC Zapi Dingbats." &5 SYSTEMS. INCORPORATED

POSTSCRIPT 5 & rt-i‘:_l'|5,|:|g-rf1j racemark of Adobe Syslems Incomporated. LaserWniter is a irademark of Apple Computesr, Ing. Helwetica Times Roman, Llypha,
COptima, and Palatino are all trademarks of Allied Corporation. 1ITC American Tvpewriter, ITC Avant Garde Gothic, ITC Benguiat, ITC Bookman, ITC Garamond

ITC Lubalin Graph, ITC Machine, ITC Souvenir, ITC Zapf Chancery and ITC Zapi Dingbats are all rademarks of International Typelface Corporation
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Registering Ready,Set,Go!

In order to qualify for Letraset USA’s
product support, please take a mo-
ment to fill out and return the post-
age-paid warranty registration card
enclosed in your Ready,Set,Go! pack-
age. As a registered user, you will be
entitled to the following services:

Technical support

If you experience any difficulty with
Ready,Set,Go!, call us at 1-800-634-
3463 Monday through Friday be-
tween 9:00am and 6:00pm Eastern
time.

Upgrade information

Letraset USA is committed to con-
tinually improving its product line.
Registered users are automatically
notified when upgrades become
available.

User newsletter

As a registered user, you will be
entitled to receive Letraset USA’s
“Communication by Design™™ user
newsletter.

This quarterly resource includes
program tips, shortcuts, design
advice, new product information,
special offers, etc.

Requirements
To use Ready,Set,Go!, you need a
512K Macintosh or Macintosh Plus
with a single 800K drive or two
400K drives.

We also recommend that you
have at your disposal either an
ImageWriter or LaserWriter printer.

Limited warranty

The program is provided on an as is
basis. The entire risk as to the results
and performance of the program is
assumed by you.

Should the program prove defec-
tive, you (and not Letraset USA or
its dealers) assume the entire cost
of all necessary repair or correction.
Further, Letraset USA does not
warrant, guarantee or make any
representations regarding the use
of, or the results of the use of, the
program in terms of correctness,

accuracy, reliability, currentness,
or otherwise; and you rely on the
program and results solely at your
own risk.

Letraset USA does warrant that
the Ready,Set,Go! System Disk and
Program Disk are free from defects
in media and of materials and work-
manship, assuming normal use, for a
period of 90 days from date of
purchase.

If a defect occurs during this
period, you may return the disk to
Letraset USA for replacement free of
charge, provided your registration
card is on file. If your registration

card is not on file, you must provide |

a dated proof of purchase with the
defective disk.

The above is the only warranty
of any kind, either expressed or im-
plied, including but not limited to
the warranties of merchantability
and fitness for a particular purpose
that is made by Letraset USA on this
program. This warranty gives you
specific legal rights and you may
also have other rights which vary
from state to state.

Neither Letraset USA nor anyone
else who has been involved in the
creation, production, or delivery of
this program shall be liable for any
direct, indirect, consequential, or
incidental damages resulting from
the use, or inability to use such
product even if Letraset USA has
been advised of the possibility of
such damages or claim.

Some states do not allow the ex-
clusion or limitation of liability for
consequential or incidental damages
so the above limitation may not

apply to you.

Copyright
The program and its related docu-
ments are copyrighted.

Except for back-up purposes, you
may not copy the program or its
documentation.

Multi-use license

To use the program on more than
one computer or with shared-disk
systems, vou can purchase a multi-
use license direct from Letraset USA.

Letraset USA

Publisher’s Notes

About eight months ago, we con-
ceived the notion of producing a
Ready,Set,Go! magazine instead of
another humdrum computer manu-
al. We hope you’ll agree that the re-
sults were well worth the eflort.

We had no idea then that the new
Ready,Set,Go! would contribute so
much to the magazine’s creation.

Automatic hyphenation, picture
runarounds, grids, find, replace,
glossaries and the multiple window
environment proved especially in-
valuable to the process of laying out
and editing this piéce de resistance.

Ready,Set,Go!, the magazine, is
based on a manuscript by David
Kater, best known for his Microsolt
Word book. Kater's manuscript was
directly read using Ready,Set,Go!'s
Microsoft Word import feature.

All editing, content amplifica-
tion, and layout was subsequently
performed with Ready,Set,Go! in
about ten days.

Adobe’s assistance in supplying
fonts, beyond the call of duty, must
be acknowledged.

We also wish we had Infosphere’s
LaserServe LaserWriter spooler from
day one. It proved to be a formida-
ble timesaver. Affinity’s Tempo was
a solid hit too. Its macros dramati-
cally speeded up repetitive opera-
tions. The simultaneous use ol
Tempo and LaserServe, underscores
Ready,Set,Go!'s solid performance
with desk accessories.

Another desk accessory worth
noling is Keith Esau’s Camera.
Camera lets you take pictures of
whatever you're doing on screen.
We want to compensate you, Keith,
wherever you are.

In order of hardware importance
were the Macintosh Plus, the Lascr-
Writer Plus, SuperMac’s DataFrame
20, and Mirror Technologies’
MagNet 20 hard disks.

Our thanks go to Richard
Mitchell, a faithful Ready,Set,Go!
user, who supplied us with the type
chase featured on the backcover.

Lastly, we thank Cynthia Ahart
for her copy ediling expertise.

— Michael Tchong

40 Eisenhower Drive, PO. Box 281, Paramus NJ 07653 Telephone 1-201-845-6100



. Set?

What you need to know
about starting Ready,Set,Go!

efore you do anything, you
should make a backup copy of the
Ready,Set,Go! disks.

On a two-drive system, place
the RSG System disk in the internal disk
drive. When the Macintosh desktop appears
(see below), place a blank disk in the exter-
nal drive.

& File Edit Diew Speciol

A dialog box appears asking you whether
you want to initialize the blank disk.

Click on the Initialize button, and wait
until the Initializing Disk message disap-
pears.

Now you'll be asked to name the newly in-
itialized disk. Type in: System Backup.

If you make a mistake, use the Backspace
key to correct your error, When you have
finished typing, click on the OK button with
the mouse or press the return key. An icon
for the System Backup disk now appears on
the desktop.

Place the pointer on the RSG System
icon, hold down the button and drag the im-
age of that icon until it is on top of System
Backup, and release the mouse button.

Completely replace contents of
"System Backup” (external drive)
with contents of
“RSG System” (internal drive)?

A dialog box now appears asking if you
want to replace the contents of System Back-
up with the contents of the RSG System disk.
Click OK. A message will appear telling you
how many files remain to be copied. Wait
until the message disappears.

Pull down the File menu and select the

Ready,Set,Go! ¢ 3
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Eject command to take out the backup disk. Now
place a blank disk in the external disk drive, initial-
ize it and name it RSG Backup.

After naming the disk, click on the RSG System
disk to highlight it and eject it with Eject from the

File menu.

Insert the RSG Program disk in the now empty
internal drive and drag its disk icon onto the RSG
Backup icon. The dialog box should say: “Replace
contents of RSG Backup with contents of RSG Pro-

gram?” Click Yes.

Once all files are copied, store

the original Ready,Set,Go! disks in a safe place.

Backing up with a hard-disk system

Copy the contents of the Ready,Set,Go! Program
disk to your hard disk.

Make sure that Ready,Set,Go! and the RSG Dic-
tionary reside on the desktop or in the same folder.

Starting Ready,Set,Go!
Insert your Ready,Set,Go! disk copies into the

Ready ,Set,Go! 3

Program icon

computer. After the screen
displays the Macintosh desk-
top, double-click on the RSG
Backup icon to open a window
showing ils contents.
Double-click the
Ready,Set,Go! program icon,
A copyright message will be
displayed briefly, followed by

Ready,Set,Go!'s desktop. Take a moment to famil-
iarize yourself with the desktop:

& File Edit famt Style Format Iest Special Fill Pen
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The top bar contains the menus from which you
choose commands. The large box with the file
name Untitled Page 1 is a Ready,Set,Go! document
window. This window currently shows the top left
corner of an electronic page.

The little white box on the top left side of the
document window closes the window:. If you are us-
ing a Macintosh Plus, 512E, or upgraded Mac, you
will also see a zoom box on the right side of the title
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bar. The zoom box alternately expands the window
to fill the entire screen or contracts it to original
size.

The vertical scroll bar along the right edge of
the window moves the page up or down — bringing
other parts of the page into view. You may scroll up
and down three ways: the scroll arrows at either end
of the bar move the page by small increments;
dragging the scroll box along the bar allows you to
scroll to a particular section of the page; clicking
on the grey section moves you to the top or bottom
of the page quickly.

A horizontal scroll bar at the bottom of the win-
dow moves the page view from side to side. Opera-
tion of the horizontal scroll bar is identical to that
of vertical scroll bar.

The size box, located in the lower right-hand
corner of the document window, lets you to resize
the window.

Along the top and left side of the document win-
dow are rulers that provide reference for placing
objects on a page. The outside edge of the blank
page is a dotted rectangle. This marks the margin
required by the printer in use.

The page scrollbox at the bottom of the screen
keeps track of the number of pages in your docu-
ment, and lets you to scroll from page to page, or
select master pages (indicated by an L and an R).

To the left of the Ready,Set,Go! screen are the
tool boxes.

Retrieving existing documents

To open an exisiting document, choose Open from
the File menu. Ready,Set,Go! displays the Open
dialog box from which you can choose any existing
Ready,Set,Go! document:

€3 Ready,Set,Go! Folder|
D Adeertising <r|e> DataFrome ...
O Art Folder | _
D Brochure | (_Eject ) !l
O Letter 4 .
D Magazine | [ _mrive ]
0O Memorandum i
D Movie script 1l [ open )
D Novel
| [D Press release (_Concel ]

The Open file dialog box displays a listing of
documents and folders on your disk.

Use the Drive and Eject buttons to select anoth-
er disk, if necessary. Cancel terminates the Open
command.

Scroll through the file list and select the docu-



ment you want, then click the Open button. You
can also double-click on a file name to open it.

If the selected drive is hierarchical, the open di-
alog box also displays folders. You open folders in
the same way as documents by dicking on the Open
button or double-clicking on the folder title. Open-
ing a folder lets you view its contents. To move back
up one level, click on the folder title above the file
listing to display the folder menu. Drag down this
menu to choose another folder.

<3 Art Folder w

= R A R RIS Dataframe ...
y — DatafFrame 20™
O MacArtDept (_Eject )
O Movie Art prive )
[ (__open ]
[ Cancel |

To move up back one level through your nested
Jfolders, click on the name of the current folder

Note: Ready,Set,Go! 3 can transilate 2.0 and 2.1

files to the new 3 format. To do this, 2.X files must
be opened from within Ready,Set,Go! 3. Double-
clicking a 2 X file from the desktop does not work.

Creating new documents
To open a new docu-
ment, choose New from
the File menu (shown,
left), or press Com-
mand-N.

If you open
Ready,Set,Go! from the
startup desktop (also
called Finder) by double-
clicking on its icon,
Ready,Set,Go! will auto-

P M Edit
™ New  #N

Save as...
Page Setup

Print...

Gt Tesl matically display a new
: document.

Pt Tesut

bet Picture Multiple windows

Ready,Set,Go! lets you
open as many document
windows as your comput-
er's memory capacity al-
lows. Each new window
partially overlays the preceding window(s).

To arrange windows for convenient viewing, se-
lect a window by placing the pointer tool anywhere

uit

Q
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on a window, and clicking the mouse once. This
will bring the window 1o the front. To move a win-
dow, click on its title bar and hold the mouse but-
ton while dragging it to a new location.

Windows may be resized by clicking on the sizc
box at the lower right hand corner of the screen
and dragging the pointer horizontally, vertically,
or diagonally.

Moved or resized windows may cover up

d& File Edit Font Style Farmat lext Special il Pen M
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A custom desktop with multiple windows and tool-
boxes moved

Ready,Set,Go!'s toolboxes and page scrollbox. To
move these items, hold down the Command key,
click on the box that needs moving, and drag it to a
new location.

An interesting use for multiple windows is to
view different pages of the same document simulta-
neously. Note: Changes made in one window will
not be reflected in the other. Use this technigque for
viewing only, not for editing.

Disk storage
Although Ready,Set,Go! can be made to work on a

single-drive Macintosh with either 400K or 800K
disks, a second disk drive is needed to use
Ready,Set,Go!'s spelling checker.

The single-sided System disk comes pre-
installed with LaserWriter and ImageWriter printer
drivers, as well as a full complement of ImageWrit-
er and LaserWriter fonts.

Higher-capacity 800K drives — like the ones in-
cduded with the Macintosh Plus and 512E — are rec-
ommended for efficiency. These drives make ac-
cessing picture libraries, large text files, utilities
and other programs much more convenient.

Ready,Set,Go! works with any hard disk current-
ly on the market. Hard disk drives that work with the
Macintosh Plus’ SCSI port are particularly effective.
SCSI drives are manufactured by Mirror Technolo-
gies (MagNet 20), SuperMac (DataFrame 20) and
AST (AST 2000 and 4000).

Ready,Set,Go! « 5
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Switcher

Ready,Set,Go! requires a minimum 312K memory
when used with Switcher. Use Configure ‘Then In-
stall... from the Switcher menu to permanently spe-
cily Ready,Set,Go!'s memory allocation.

Ei Ready,5et, 6ol Configuration
=l

FPreferred Memory Size

Minimum Memory Size

=] Save Screen

|Permanent| |Temporery |

The Swilcher configuration dialog box lets
you install Ready,Set,Go! correctly.

Where to go from here

You may have noticed that this is not a typical us-
er's manual. We decided that an innovative prod-
uct would be better complemented by a similarly
auspiCcious magazine.

Moreover, what better way to showcase desktop
publishing and Ready,Set,Go! than with a publica-
ton created entirely with this advanced technolo-
gy. The magazine is divided in two sections.

Feature articles present Ready,Set,Go!'s page
composition capabilities in detail. If you would like
a hands-on demonstration, proceed directly to the
next article A Quick Tour. If you prefer to skip the
Quick Tour, then read the articles that follow.

The Essence of Ready,Set,Go! explains blocks
and objects. Document Design provides informa-
tion on adding pages and grid systems. Processing
Words covers text entry, formatting and block link-
ing. Picture Perfect discusses the addition of graph-
ics. Prinout! gives a printing and saving overview.

Layout Basics gives the novice desktop publisher
some basic design advice.

The second section contains On The Menu, a
reference section on Ready,Set,Go! menu com-
mands; a Glossary, listing popular desktop pub-
lishing terms; and the ndex.

For advanced users

If you feel comfortable with all aspects of Macin-
tosh software and have a fair amount of desktop
publishing experience, we recommend that you
read Processing Words to gain insight into
Ready,Set,Go!'s powerful hyphenation, kerning
and block linking concepts and suggest you use On
The Menu as a reference guide.
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The Font/DA Mover

The Fon/DA Mover (Font and Desk Accessory
Mover) is a Macintosh household program that
copies or removes fonts and desk accessories.
All program startup disks contain fonts and desk
accessories in the System file (found in the Sys-
tem folder). "
To add new fonts or desk acue:ssumstuthe
‘Ready,Set,Go! System disk, you use e
Font/DA Mover. |
‘1. Double-click the Font/DA Mover icon.
2. The Font/DA Mover will list your System’s

- fonts in the left window upon startup. To add
- desk accessories, click on ﬂmDeskAmw
button displayed in the dialog box. The list
_..dﬁqﬂmﬂmﬂmhﬁm@dﬁgﬂMmm
~accessories contained in the System on the
~Ready,Set,Go! startup disk.

3 uxdcuaepenmumm'wtmofmh-

er System, font, or desk accessory files on any
‘other disk. Each open button controls what is
displayed in each list. Both the file and the dis’k

'uisonﬂ;reshmbeluweadihst(:ﬁcktfm

Drive button to view files on «-ther disks.

4. Openaﬁlebydmbl&clmigﬂm
5. Select the fonts or desk accessories you

-_-_mmmpynrm You mmm_
.MfmdMMMEMiW'ﬁ&-
..mmmmmwmhmm

_ammnumhunf mmmm

is ____ged(if

e

imme,mzemdlfcunﬂmplem __

‘desk accessories or more than one font mseba
‘ed nothing is shown).

6. Click Copy or Remove in the direction lhe
arrows point to copy or remove fonts or desk

‘accessories. Clicking Copy copies them to the

opposite file; clicking Remove remttmn
from the file they are in. (You will not be al-
hﬂmwmﬁmﬂwﬁmm "

needs.)

7. Click Quit.
| T@ﬁlﬂympyﬂmmmmlﬁdﬁkaﬂm:
ries and unlimited fonts the Macintosh allows,
you'll need 800K disk drives or a hard disk. (The
system folder used for this magazine contains
close to 1.2 megabytes of information)
_ Read}rSet,Go'userswhurﬂdmwmkmth
Mdﬁkdmfesshmﬂdmfermﬂmfdlmg

's:deba:, A One—ﬂnw \Sjmm
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A OneDmve System

It is possible to use Ready,Set,Go! on a single
400K disk drive with one typeface family. To
make room, do the following:

* Remove all unnecessary fonts from the
System file except the one you'll be using. If you
use an ImageWriter remove all LaserWriter fonts
and vice versa.

* Remove all desk accessories except
Chooser and the Control Panel. (You need

- Chooser to select the printer and the Control
ut tnqether and Panel to turn on AppleTalk.) '

* touch up for % Now trash the Font/DA Mover.
greater - % Remove two of the three printer drivers
i included in the System Folder Gi.e. AppleTalk

P

i ImageWriter and LaserWriter xf mu are usmg the
— ImageWriter).
-: "“'-"-'"m"'-::' % Trash the Fmder and rename
e | Ready,Set,Go! Finder. When you startup the

‘ "-"r'urmulll““” :
LI 0T

disk you'll immediately begin Ready,Set,Go!
instead of seeing the Finder desktop. Since you
are not able to quit Ready,Set,Go! 1o go to the
Finder, turn the computer off to quit. Hold the
mouse button down while t.’ne computer rebmts
to eject the disk. '
~ Used this way, you can have a System Folder
and Ready,Set,Go! on one disk and still have
“about 50K left for documents.
- Unfortunately, you will not be able to use the
- spelling dlecker ‘with this smppedﬂdawn S?S{ﬁm
Yersion. -

““llllmﬂli" -""
SR TIIITL I T
s s L T 1':

""“'l T e

-y i
Sl LTI IH'

u‘”" Wi “F“'
N

Lth coin is landing on
stack switch to

shaded top coin (1) for depth.

Shade Lasso and stack.

Ready,Set,Go! 5



Enhancing Ready,Set,Go!

Software

Ready,Set,Go! readily uses pic-
tures and text created by other
applications. Useful programs
for desktop publishing include
drawing programs like

an additional 32K in each mem-
ory partition upon installation.
MacServe also overrides Ap-
ple's Chooser desk accessory.
To switch printers, use Page Set-

find a scanner useful. The best-
known scanners are those manu-
factured by Abaton, Datacopy,
Dest, Microtek, and Thunder-
ware (Thunderscan).

Any MacPaint-

FullPaint, MacPaint,
MacDraw, MacDraft
and Easy 3D, and
clip-art libraries like
those manufactured
by T/Maker under the
ClickArt label and The
MacArt Dept. by Sim-
on & Schuster.

You can store rap-
idly expanding clip-
art libraries in Picture-
Base, which lets you
retrieve art quickly
without long searches
through many fold-
ers.

Although
Ready,Set,Go! has its
own word processor,
it reads files created
by Microsoft Word
and MacWrite. Files
created by ThinkTank
and MORE can also be

compatible file created
by these scanners can
be read directly by
Ready,Set,Go!

Ready,Set,Go! has been
successfully tested with
large monitor screens
from E-Machines, Mi-
crographic Images, and
Radius.

To use some of these
monitors, your Macin-
tosh needs to be modi-
fied by the screen'’s
manufacturer.

With these large
SCréens you can view
several Ready,Set,Go!
documents simultane-
ously in actual size.

Fontographer
All typefaces created

imported in the text
(ASCID) format.

Macros
To speed up projects that
require repetitive commands
you can use Ready,Set,Go! with
programs like Affinity’s Tempo.
Macros were used with this
project to store frequently used
set/clear paragraph indent com-
mands.

Network software
Ready,Set,Go! has been tested
with the MacServe network from
InfoSphere.

MacServe requires two minor
adjustments. When you use
Switcher with MacServe, reserve

A drawing created with Easy 3D and imported from
the Scrapbook

up from the File menu and click
OK. Consult the MacServe user’s
guide for more information.

Modems

Use a modem to send articles to
other Ready,Set,Go! editors.
Modems also let you send docu-
ments [0 copy Or typesetting ser-
vices for printing on high resolu-
tion output devices

Scanners
If you intend to use existing line
art or other graphics, you may

with Fontographer are
compatible with
Ready,Set,Go!
Fontographer pro-
duces typefaces that are
automatically downloaded to the
LaserWriter whenever needed.

LaserWriter spoolers
Infosphere’s LaserServe spooler
works with Ready,Set,Go!

Please note that any down-
loadable fonts should be down-
loaded before spooling other-
wise they will not print.

8 * November 1986 o Ready,Set,Go!




A Quiick Tour

Now that you have made Ready,Set,Go!
backup copies, you are ready for a
hands-on tutorial. o '

-
Familiarize yourself with the Macintosh
desktop, including how to use a mouse,

- keyboard, windows, icons, menus and
dialog boxes before you begin. If neces-
sary, review the basics by consulting your
Macintosh user's manual.

S tart_{ng Ready, Sﬂt, Gﬂ! L

To start this quick tour, turn the Macin- e R o e SR PR e~ B
tosh on and insert System Backup disk in
the internal disk drive and the Program
Backup disk in the external drive. The

& Flle

=

& Flle EdiY Fami fiyla Forrnal Tesmt Special FIIl Pen
Untified Fl!l i

Macintosh desktop will appear (see top, = AR AW Y. WY, W Y.
— right). e g
Point on the disk icon and click the = kB
mouse button twice in rapid succession e
(double-click). Now double-click on the —
~—  ReadySet,Go! icon. -
After a brief delay and a copyright no- e
h tice, you will see the Ready,Set,Go! desk- e
top shown at right. =

From this desktop you will begin to e

create your first document.

Ready,Set,Go! » 9



At the left side of the screen are Ready,Set,Gol’s
toolboxes. From left to right, you see the pointer
tool which is used to select, move or resize objects
and the I-beam tool which edits text.

One row down, is the cropping tool (crossed ar-
rows) which selects picture blocks and moves pic-
tures within them. The linker tool (lightning bolt) is
used to link text blocks. The T stands for text block
tool which creates text blocks. The rectangle tool
draws boxes.

The X tool is used to create picture blocks. The
three last tools draw round-cornered rectangles,
lines, and ovals.

Immediately, below these tools are the
Ready,Set,Go! line patterns.

These patterns can be applied to lines and the
borders of rectangles, round-cornered rectangles
and ovals.

Since lines and rectangles are often used in
desktop publishing, the patterns have been placed
on the desktop for easy access.

The top bar contains the command menus. The & Flle EdIt fani Style Format Teut Special Fill_Pon
large box with the file name Untitled Page 1 is a
document window. The window currently shows the
top left corner of a Ready,Set,Go! page.

Scroll bars at the bottom and right side of the
window move the pages left and right or up and
down. To resize the window, use the size box locat-
ed at the bottom right of the document window.

Along the window’s top and left side are rulers
marked in inches to help place page objects. Below |
the window is the page scrollbox which lets you 5

move between pages b}r Clleiﬂg on numbered page E"].ﬂixﬂiﬂﬂl:tﬂiliih‘ihhiihliiﬂlliiﬂllﬂmﬂillkiiihlil;l’li;i['I:;.f
- TR - e ——

Now let’s start to design a document. Select Prefer- %

ences from the Special menu. A dialog box will ap- Preferences

pear that lets you specify the measuring units used
by Ready,Set,Go'’s rulers and spec sheets. o ERE:
The unit of measurement can be changed at any O Iathes Grid O @
time during the document creation process.
Click on the Centimeters button, and click OK. © Centimeters Ruler » &
O Picas/Points Start Auto
Page
numbering | [N
I [  concet |
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Choose Size to Fit from the Special menu. You can
look at and work on Ready,Set,Go! documents in
several different views.

The Size to Fit view reduces the document to
show the full page. Half Size, 75%, Actual Size and
Double Size are progressively larger magnifications
of your page.

All views are fully interactive — you can lay out a
whole page with Size to Fit, enter text in Actual Size,
then visually align objects in Double Size, for ex-
ample.

& fie

Edil lami Stygle | ocmal

[ special L
size Ta Fit |
Hall S1ze

_LL|_I_‘_.LJ_I_.i._,L_]_J. Lad ...!J.J. Ll I._I_El_

5% sire

SACTual Si7e
Double Size

—ne|

e

Insert Fagels)
Delate Pagais)
Ga lo Page &
Facing Pageas XD

Freferences
Turn S%nap To Dn
HUse HMasler
Design Grids
Filiejrnrmienid
SpochTic mtions
Biwmg Lo Frant
Send Belond

e it

S ———_ o
o

Design Grids position items on the page. Select
Design Grids from the Special menu. A dialog box
with various preformatted grids will pop up. Click
on the 8 Column/8 Row button.

Now any page object you create will automati-
cally snap to the nearest grid lines. This makes
creating multi-column documents literally a snap!

You can customize a grid by entering your own
specs if you dlick Grid Setup. You can also compose
free-form pages with no grid at all. Or combine
free-form with grids by turning snap-to on or off
from the Special menu.

Now click OK.

Dasign Grids

Oimi
| O2md
H O3Inld

CAm 4

) Grid Selup

O5SusS

ol TR
OTu?

Choose Insert Page(s) from the Special menu. Se-
lect Insert Blank Page. You can create a document
of any length — limited only by your Macintosh's
memory — by filling in the Number of pages field.

For this sample we need only one more page, so
click OK.

Notice that another page icon has appeared in
the page scrollbox and that you are now on page 2.

Click on page icon number 1 to go back to the
first page.

F

# Fite Edit foni Sigle Formai Teut

Filt PFen

Untitied Fuge ]
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@ Insert Blonk Page

@ Insart After Currenl Poge

) Imsert Before Current Fage

O Duplicate Current Page

Links: & ~one o Logel <5 Blobal

Number of pages |-

(ox, ) GTTT)

Begin laying out your first page by selecting the pic-
ture tool and drawing a picture block as shown.

You build blocks by clicking on the page where
you would like your block to begin and dragging the
mouse in a diagonal direction — usually down and
to the right.

Don't worry about being accurate, the snap-to
grid takes care of the details.

If you end up with a larger picture block than
you intended, hit the Backspace key and the block
will disappear. Then try again.
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Now you are going Lo pIECE a graphic in the picture " & File DGt laml Style Tarmat fewt Special Fil Pen

block. Select the picture block you just created by | ntitied Fage | ise———
gl b e da b bo e ntgbedebodadadabodolelell

clicking on it with the cropping tool... . P
-
p
-
~ :
.-.1
=
i)
_|
...choose Get Picture from the File menu... " NI idit tam Style foomal Tewt Speciel il Pen )
?r:: bl batelptadadotatedadaliladalyl]
li.!f i ---“I-.--- ---...“.-!:
faue 8. -
Grid Selup
Fage Selup #} iy 'ﬁ#
Print... .:
ek Tewl Tl mios b
:'..I e !--—'
...OpPEn the Chart file b}-’ dDUh]E—C]iCkiﬂg on its T cait iont Siyle Formal  [est Speciel Fill Pen
name... Untitled Page |
2 : pdebadebadbebo oty iadabsbalateladalolals
[ RsG Backup]
= RSG Backup
T Eject
: Drive |
(_Ooen_ )
" Coancel '
o -Hﬂd [hEI!'E‘.’ il 18! " & Ffe Edt fam Style [Tomal  Test Special Fill Pen i
= X H - o _ : 5 S
Position the chart within the picture block by — Uititiea Page | le m—
. . " - . i 111 | 14 11 (13 L& ]38 1 | . Jidaly)
dragging the cropping tool in top left direction. ¥ e
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Now let's create some text columns. Select the text
block tool and draw four columns of any size. No-
tice how text blocks snap to grids.

(If you prefer, you can draw free-form blocks by

" & re Eait fom Style  Farraatl  Teut Spacial FIl Pen
ki T T R e ————
3  Jelsbad el el adabalaluli

E B e
turning snap to off in the Special menu. But we will —IOf - I_l [\H]7
continue to use Design Grids for a while longer.) =l E kg HHH
—t (i)
s 2 ]
ol EJ (e
o E [T
E QD
Click on the page 2 icon. Since the text block tool is " & File (@it lant Siyle favmal Tent Special Fill_Pen
still selected, create one more text column about 3 % | | [ " U |ie 1 o e 7
BfidSEC[iﬂﬂSWidE 5 be, abladlsdadadsdadadyptadadodalalsdeldalalall
Then add a large picture block with the picture TD -
tool to fill up the rest of the page. =e ki
The grid system lets you lay out pages with maxi- e Bl
mum flexibility and makes position calculations =13
unnecessary. w—
s
. = +
f QL

Return to page one by clicking on the page 1 icon.
Select the linker tool and link all text blocks on the
page by clicking inside each column.

After the first column is linked, the linker tool
will flash to acknowledge that the current text block

is being linked to the previous one.
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& File [ail Tonl Style Fermal

Test Special Fill Pen
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To end the sequence, go to page two and link its text
block by clicking on it twice. (A double-click lets
the program know that the text chain is complete
and allows you to immediately begin linking other
chains.)

You may link text blocks before or after they are
filed with text, in any sequence. This lets you run a
story from page one to page four, another from
page two to five and back to three, elc.

" & File O Fant Style Farmat
Untitied Page 2

Teut Specisl Fill Pen

tladledaodadadatild

Lo dodododebododolulbeb
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Click on the page 1 icon. Select the I-beam tool,
and click on the {irst text column.

Go 1o the Special menu and select Actual Size.
Now lype some letters in the block.
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Ready,Set,Go! has a powerful, built-in word pro-
cessor. To get a feel for its versatility, pull down the
Text menu. From this menu you can access popular
word processing features such as find and replace,
automatic hyphenation, glossaries, tabs and a
60,000-word spelling checker.

You can use this word processor to enter, edit,
format, and proof all your text. Alternatively, you
can import formatted MacWrite, Microsoft Word
or text files (ASCII) directly.

The replace feature finds occurences of words
and replaces them throughout any article. Cancel
this dialog box now by clicking Cancel.
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Find...
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We'll import a text file here to quickly demonstrate E (Mt font Style formet Tewt Special Fill Pen
how text flows. Select Size to Fit from the Special e Untitied Page |
menu. Now choose Get Text from the File menu. e sy B
. T Save =5} R
If nothing happened, check to make sure you &gl sewess. | g—
have an insertion point in the first text block by T e ll
clicking on it with the I-beam, then select Get Text el PN psset
ﬂgﬂiﬂ, bet Pictun :
Qi L

— B .

wesll -

(11 mpe

—

——pon
Open the Text file by double-clicking on its file « £8it_Font Style Format Tewt Special Fill Pen ;
name. Text flows into the blocks in the order they " Untitied Page |
werelinked. w0 pled e bedaldadodatpltatododadalsltofololadi

E —

-~ E [ A5G Backup]
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Select the I-beam tool, and gel an insertion Pﬂin[ " & File At Font Style Tormat Tewt Spacial (i1 Pen 3
in the first column by clicking on it anywhere, then

k | il (01 1ied Poe | s
enter some more text. (It doesn't make any differ- X thibtbdibe bbbttt el
ence what you type. We are only trying to demon- HRieE —~ ==|

. : 43 i ph| ) - 3 - |
strate Ready,Set,Go!'s dynamic ediling capabili- ~oldi= Il =
ties.) g 1 lle 4

Although you would normally add text in Actual =B St =0 ;—iﬂ;—::: f
. . ' _ me— EuzT wwn 5SS
Size, this view clearly demonstrates how text chang- s
es ripple throughout an entire article. =l ===

- e

- 2‘;,':5“15:-‘:.“ __:'?_T:-

sl EE S BT R

Choose Select All from the Edit menu. The entire
article is now highlighted — including page two. (If
this did not happen you may not have had a text in-
sertion point. Click anywhere in the chain with the
I-beam (o get an insertion point, and choose Select
All again.)
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Select Justify from the Format menu. The entire ar-

ticle will now reformat itself with flush right and left | Rl
justification. AL Center

It is also possible to change font, point size,
linespacing, paragraph spacing, indents, etc. once
ext is selected.

=y Parsgreph Indent
=4 Right Indent

25 Kerning
xry Letlerspacing

| Line Spacing
Faragraph Spacing

Ty

Lafl Indent

Shift Up
Shift Down

= Hate Line

Select the pointer tool and click on a text block.
Handles will appear that let you resize the block in
any direcuon.
Toggle Snap To off from the Special menu. Now
resize the text block by dragging any of its handles.
As you resize one block, text reflows throughout
all linked blocks.
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Insert Pagel(s)
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Go e Page #

Facing Pages XD

Preferences

<lUse HlilE

Design Grids
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Picture blocks can be resized in a similar way. Click " & file Edil Tent Siyle farmal Tewt Specisl Fill Pen
on the picure block to make it active and grab one e —Un 111160 Pre | e
Df its handles. phabebadadadubobpdotebobualadefobalaleld)

Resize the picture block in any direction. If you
make the picture block large enough to cover some
of the adjacent text columns, you'll notice one of
Ready,Set,Go!'s most powerful features: automatic
text runarounds.
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Let's explore this feature a little more.
Select the picture block tool. Draw a picture . e L
block from the middle of the first column to the e
middle of the second column.
Watch how text flows around the picture block
automatically.
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Select the pointer tool and move the picture
around by clicking on it and dragging it some- L eeee———Untilied Page |
where. ﬂ.gﬂil’l, text will I'E‘:ﬂ{}w iﬂSlﬂﬂ[i}f to l*Eﬁl lhEt .I”ll.lJllll!!lllL!I la b dodad ol dadataldaly
picture block's new contours.

Any Ready,Set,Go! object can be designated as
a runaround by selecting Run Around from the Spe-
cifications dialog box in the Special menu. This lets
you to flow text around a large quotation, for exam-
ple.
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Choose Actual Size fI'Dm Lthe Spﬁﬂﬂl menu. S-E].El:t " & File Edit Fent Style Farmal special Fill Pen 2
the I-beam and double-click on any hyphenated X [ Sat ot i
word. The word will be highlighted on both lines. g e e e o i PRI
_ . G Bt i Fsi RO Gl aeie
Choose Hyphenation Off from the Text menu S b of warks of artl | wyphenation on witt brodl
and the entire word will wrap (o the next line. This = ;fril;:tlh: :T;:rnsn:.' Hyphenation [nc Xitions 3.,1::?,""
option lets you selectively turn off hyphenation e et E oo -
word by word or for an entire range of text. e g 0 ‘
4 . - Check Spellin 5
Rehyphenate the word by choosing Hyphena- - Ahe work of Vi~ . Co L :
tion On from the Text menu. = sl e L PE .
ase the Brookiyn mu-. hewn in :
L ‘seum. It broke out. -°"%°" .
T whan Dr. Armend and IL i% e [

QO
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Get an insertion pc}mt before the word and back- " & Fie Edil Fent Style Format Text Special Fill Pen

space slowly. The word is automatically rehyphen- Y | [Ee—————mmme————
rought up a line. x : : S e T,
ated ‘H.Ild b . g 4 . $ 8 - abatvikrbidiedpin It broke out when confirmed—we ¢
Typing in extra letters changes hyphenation au- BIOH ] | Oty unicorn met uni{ be quite sure tnfl
tDmﬂ.UCﬂ”Y. REHdY,SE[,GGEIS real-time h}rphena- =0 4 ‘from the Intrinsic: :E‘:It?;:;.ﬁ i:*:u'::n:ruk : ,i‘
tion does not use a dictionary. Instead, it relies on e j fﬁ:::,'.‘:'_m;“‘::i tepestries at ihe | The Chinese o [3
a sophisticated algorithm that is fast enough to hy- — & e conditton. ] roke out ' -
! p— Breks out WS when the ot
phEﬂﬂ[ﬂ as you Lype — u:: iﬂ 5 w:_- .:’:nlu;u‘ 3 ti
== ‘cent van Gogh was. - » f
] shown in bulk ul:' :.'“h::':. E ﬂ
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Choose Size to Fit from the Special menu. Make the
window smaller by dragging the size box to the left.

" & File £dit Font Style Formet Tewt Special Fill Pen
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Saving your documents frequently is a very impor- Nl pem— e e
tant aspect of computing. This lets you retrieve re- o Y T ,f‘l T T S T
cently saved documents, should any mishaps oc- Il _sowe  ms """z
cur. Let's save this document now. e T e

Select Save as... from the File menu and type in o e -
the name Quick Tour, then click the Save button. Get Tewt b s S5

Alter a few seconds, the lile's name appears in
the window's title bar. =255

I - -
| i T e e -

g e Wl iy

Select New from the File menu. This opens a new

document window. :f:'" :ﬂ,[ Palitadilsl
Ready,Set,Go! lets you open as many document Swe w8 I

F aUE 8. e
windows as computer memory allows. Grid Selup S5
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In the new window change the view to Actual Size " & Ffile Edit font Style farmat Tent Specisl Fill_Pen

(Special menu). Now select the text block tool and 3P Quick Tour Page |
d k of the s imate di ' % Unitind Poge | S —
raw a block of the same approximate dimensions = D PN, PRI PRRTPIY. IR PR
as shown here. =m BIE
T L e ————
e
-l
_— : :
ol
EEN s
E _%-.: w ] L]
— e B TRy
Select the I-beam tool and click on the block. From _ & fie tain fant Style JETERTR rent Special bl Pen ;
the Font menu choose Times, and from the Style x [ - Quick Tour | O A L S
; - : ¥ [ —————
menu choose 24 Point. "?hmﬁ = I atadonalon, J::::i:u _.I:.-_l_-il_.-_.l_n_._-_.l._.-_!L-_u Lad
Now press Caps Lock and type the words m BlE e
PUBLICITAS PARCIVAL in capital letters in the text —IOH 1 T rongnsiningl
block. (Since we're still in the Justify mode, h.:tters B E "?E m“;;};}f;ih e  PARCIVALJ
will come in from the right.) Notice the spacing be- =131 Lart ineat
tween the letter pairs TA, PA and VA. — E|E RN
Choose Select All from the Edit menu. With o Bl BT
both words highlighted, choose Kern from the For- il = orsh A
mat menu. Instantly Ready,Set,Go! tightens (kerns) seng 4 < |~mase Line
the spacing between TA, PA and VA. — E._ - . } =

=== S & a E = = — = =

You can also H'lEll"lLl.ﬂH}’ kern a text range. IF}’UU are & file [ail Fant Style farmat Tewt Special Fil Pen

Rl Lk

using a Macintosh Plus keyboard, hold down the X _Quick Tour Page | e
Command key while hitting the Left Arrow cursor e W T PTRTITT YWY TR . |
key. Every keystroke will tighten the words by one % = i ) '
point. = 7 i W e m S —
If you hold down the Command key and press = EiE PusLiciTAS EARE[VAL
the Right Arrow cursor key instead, the letters will ===
space away by one point. _— 3
Try Command with the up and down arrows to ---H4 1
shift some letters away from the baseline. e g
o= 111 o
: & R AR R LTI

If you are using a 512K Macintosh (or would like to
control kerning via the dialog box with a Macintosh

& Ffile [t fant Style I TIE lext  Special Fill Pen

R e Ty aaat
4 55 Fe T
1.5 884

E Quick Taur Page 1

Plus), hold down the Option key, then pull down T 1 : Y . BT, SR
the Format menu and select Kern. In the dialog box 9l 3 —
enter a2 2 and click OK. g Kern 2 p— =

This action will tighten the spacing between let-
ters two points.
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Select the PUBLICITAS PARCIVAL text block with
pointer tool and choose Copy from the Edit menu.

"% e TN ont Siyle lormal Ieul Special THI Pen

intitied Page | _
—
L I..I.J..I._d'_l_l_I!L.I.J_l_l_l_l_nlﬂ_l..-l.l ladalotelal

) T T | Il._llll

Move the Untitled window to gel to the resize box " & fne tont Style lovmnat  Tent Special Fill Pen i
by clicking on its title bar and dragging it up. Resize THed "™ "7 )reage | meees Unlitied Page |
it so that Quick Tour becomes visible. Click on the i, = l;;-; = T
ick Tour window to make it active. :-m_n’ | == c —
Qucmase Paste from the Edit menu. The text =s EEEEMNE | PysLicIT
block you just created in the Untitled window now o et ) = 8 BE
appears in the Quick Tour document. — Bl 1 |
You've just transferred material between two dif- =SS NERE S
ferent documents. You will find this a very useful T - 2 S E:E—::; fr_-_-"-fg:i 1
feature in desktop publishing. senly 4 F g g 1 |
snn il | oot o b i I
— 2

=

The block you just copied to Quick Tour was placed
in the same location as where the original was

created in the Untitled window. _ﬂ. g

You can, however, position this text block very Jemy e [T ches S
accurately on the page with Specifications from the I ] AR 0 '
Special menu. This dialog box lets you enter pre- " |% Width 451 mcnes |/ BLICIT
cise coordinates and dimensions spec-sheet style 105y e 2.2083 nches
for any page 'Dbj{‘.{:L ; E‘-fz_l T Postscript (] hun Rround

(The PostScript option lets you program the La- - EEE_-_'_ ) (Cancel)
serWriter directly for special effects, like rotating n [ iy | S —————
text.) m fLS

Click Cancel 1o close Specifications.

T{} Eﬂd [hE QUiCk TGUI', IE['S -C],DSE [hE U?HIIIE‘{:{ Win- : i nm Emit Ffant Style Format Tewt Special Fill Pen 2
dow. Click on the Untitled window to make it active ' S tour Toge ] g—
and click its close box in the upper left-hand corner e e, 21 SRS S St
of the window. !-gf’:: 1’:5_:':;—; i
(Notice that, whenever you change windows, the TR T 1 ?ér:'“::il Jd | P | |
page icon list changes to reflect the newly-selected G 3 | vBLiciiqg
document.) === %:‘g-;-:' ] |
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A dialog box will appear asking you whether you " & File EON fomi Style formal Test Specisl Fill Pen

want to save changes belore closing. We don't want Quick Tour Page | Untitied Page |
o save lhf‘: Uﬂfﬂfﬂddﬂﬂlmﬁﬂ[ S0 CliCk on lhﬁ No _Illll|I|I|l|.I-|1.I-]. L1l ..1.1.|.1.1.1.L1J_.-.|.
button. 3 B |
= L]
182 GE ;
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Ready,Set,Go! is an object-oriented desktop pub-
lishing program. With the toolbox, located at the
upper left of the screen, you can create seven types
of objects. The objects are: text blocks (the one
with the T), picture blocks (block with crosshairs),
rectangles, round-cornered rectangles, ovals, and
horizontal and vertical lines.

These objects can be manipulated, either indi-
vidually or in groups. This is done by selecting the
object(s) and performing an operation, such as
moving or changing size(s).

To create an object, first click on the desired
tool and then move the pointer to the spot on the
page where you want to place one corner of the ob-
ject. Press the mouse button and drag to where you
want the opposite corner, then release the mouse.

Several objects drawn on a single page may
overlap each other (see illustration above). Each
object is actually on a single plane, with the most
recently created object on top.

Newly created objects are automatically select-
ed. If you create several similar objects, however,
all are selected until you click on another tool.
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Essence of

Ready,SetGo!

Understanding the
concept of objects
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Selecting objects

An object must be selected be-
fore it can be manipulated. With
the pointer tool, click on the tar-
get object. The target object is
now sclected. Selecting a new
object deselects any other ob-
jects on the page.

When an object is selected
small squares, called handles,
appear. These are used 1o resize
the object.

If you click repeatedly on an
object with the pointer tool,
while holding down the Shift key,
that object alternates between a
selected state and an unselected
state. If one object is obscured
by other objects, the ones on
top must be moved before the
objects beneath can be selected.

To access obscured objects,
click to select the object on top,
then choose Send Behind from
the Special menu. Repeat this
process for the other objects un-
til you can select the one you
need.

Group object selection

To select more than one object,
use the pointer tool and point to
a blank area of the page. Click
and hold the mouse button, and

drag the pointer diagonally
through the objects to create a
rectangle that contains all of the
objects you wish to select.
When you release the mouse
button, every object within the

rectangle’s area is selected.

Selecting additional objects
Normally when you select an ob-
ject, any currently selected ob-
jects are deselected. By holding
down the Shift key, you can se-
lect additional objects without
affecting objects already select-
ed. This technique works wheth-
er you click on a single object or
drag to select a group of addi-
tional objects.

You can select all objects on
a page by using the Select All op-
tion from the Edit menu.

Deselecting objects

As above, an object is automati-
cally deselected when you select
another object. To deselect a
single object of a selected group,
Shift-click on the object to be
deselected. This object is then
deselected and no other objects
are affected. To deselect all se-
lected objects, simply click in a
blank area of the page.
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tain objects.

Resizing objects
You can resize objects with the
pointer tool. Click on a handle,
and hold the mouse button, then
move the mouse to a2 new loca-
tion and release the button.
Ready,Set,Go! objects have
two handles for horizontal

kA > K
E’hy < 4R"

4 “>
KA+ /KA
N + "]

stretching and shrinking, and
two handles for vertical stretch-
ing and shrinking. Four corner
handles resize the object in both
horizontal and vertical direc-
tions.

When you successfully grab a
handle, Ready,Set,Go! displays
the border as a dotted line.
Dragging one of the handles off
the screen automatically scrolls
the window allowing you to
stretch a object to any size.

Moving objects

Objects can be moved with the
pointer tool. Place the pointer
in the middle of the object,
click, and drag the object to a

" new location.
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Dragging an object past the
window border automatically
scrolls the window. If several ob-
jects are selected, the entire
group can be moved by pointing
to one selected object and drag-



ging it to a2 new location. The
other objects will move in uni-
son.

Specifying objects
Ready,Set,Go! objects can be
moved or resized with the point-
er tool. For more precise work,
you can choose Specifications

from the Special menu, to exam-

ine the object’s specification
sheet and use coordinates to
control the exact position and
dimensions of the object.
Specification sheets vary with

Rectangls Spacifications

Start Rcrows 5%

Starl Doun 1.4722

Width 2.0000

Dapth

the type of object selected, but
all have Start Across and Start
Down coordinates. The posi-
tions indicated in these fields are
relative to the upper left corner
of the page.

With the exception of lines,
all specification sheets also con-
tain fields for width and depth.
Horizontal lines only have a
Width field, while vertical lines
only have a Depth field.

You may resize and reposi-
tion the selected objects with
precision by changing any of
these numbers using the mouse
and the keyboard.

Specifying multiple objects
When Specifications is chosen
with more than one object se-
lected, Ready,Set,Go! will
display a dialog box for each ob-
ject in sequence, Click OK or
Cancel to display the dialog box
for the next object.

Using the clipboard

The capabilities of the clipboard
change with each tool you select
from the toolbox.

When working at the object
level with the pointer tool, the
clipboard can hold an entire ob-
ject or group of objects. If you
want to duplicate an object, use
the pointer tool to select the ob-
ject, then choose Copy from the
Edit menu to copy the object to
the clipboard. Choose Paste
from the Edit menu to retrieve
the object. The pasted object
will appear in the exact position
of the original object, unless the
original object was moved prior
0 pastng.

Once an object has been
copied to the clipboard, the
original object can be moved or
deleted without affecting the size
or position of the copy in the
clipboard.

You can duplicate groups of
objects by selecting the objects
and using Copy and Paste. Once
in the clipboard, objects may be
pasted onto another page in the
same document or even a differ-
ent document.

Deleting objects

You can delete objects using one
of two methods: with the back-
space key or the cut method.

To delete an object or group
of objects using the backspace
key, select objects to be deleted
with the pointer tool then press
backspace. The objects are
erased from the screen.

The Cut option (Edit menu)
also deletes objects. Unlike the
backspace method, cut objects
are copied to the clipboard and
can later be recalled with Paste
(Edit menu), providing nothing
else has been cut or copied to
the clipboard in the meantime.

Aligning objects
Ready,Set,Go! can align multi-
ple objects precisely using the
Alignment option from the Spe-
cial menu. This may be done
horizontally and/or vertically.
First, select the objects to be
aligned, then choose Alignment
from the Special menu.

For left, right, top, and bot-
tom alignment, the selected ob-
jects are aligned with the border

RAlign Blocks:
3 Lafl Sldes ) Taps

) L/R Cenlers

) /B Canters

7y Might Sldas

of the object that lies farthest in
the chosen direction.

To align centers,
Ready,Set,Go! calculates a new
center and aligns all selected ob-
jects to that position.
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Bring to Front/Send Behind
Ready,Set,Go! objects may
overlap each other on the two-
dimensional plane of the page.
You may change the overlap or-
der of the objects by selecting
one or more ob-
jects with the at
pointer tool and !
choosing either
Bring to Front or
Send Behind
from the Special
menu.
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Double Size
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group moves to
the front or be-
hind but the se-
quence of the in-
dividual objects in the group rel-
ative to each other remains the
same.
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How to layout Ready,Set,Go! pages

he first thing you should do, is
customize Ready,Set,Go! for your
particular needs.

The preferences dialog box,
found in the Special menu,
presents you with several options:

Preferences
Units Show Hide

O Inches Grid O ®
@® Centimeters Ruler ® Q
O Picas/Points Slar! Auto

Page

Numbering | CNEEG_

[ Cancel ]

Choose measurement units: inches, cen-
timeters, or picas; show or hide the ruler;
show or hide a layout grid; and a start num-
ber for automatic page numbering. The de-
fault settings are inches, show rulers, hide
grid, and start automatic page numbering at
page 1.

Your choice of measurement units affects
Ready,Set,Go! in several ways. If Show Rul-
ers is checked in Preferences, the window
rulers will use the selected measuring system.

Rulers are visible to the left and top sides of
the document window:

Rwler guides
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Rulers help place items and size them on
the page with reasonable precision. Two in-
dicators, one on each ruler, show the posi-
tion of the mouse pointer at any time. As you
scroll the window, the rulers change to re-
flect the current position.

The measuring system you select also af-
fects object coordinates in Specifications
and the Design Grids both available from

the Special menu.

Design Grids

To make layout easier, Ready,Set,Go! pro-
vides a grid system that helps position ob-
jects quickly and accurately on the page.

Ready,Set,Go! e
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Adding Pages

Once a grid is activated,
blocks you create or resize aulo-
matically snap to the nearest grid
lines.
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A grid created with Grid Setup
from the Design Grids dialog

Show Grid in the Preferences
dialog box makes the current grid
visible — Hide Grid does the op-
posite.

The Design Grids dialog box
(Special menu) lets you choose
from pre-formatted grids —
ranging from one column by one
row to eight columns by eight
rows — or lets you customize
grids to your own specifications.

Clicking on any of the pre-
formatted grids automatically
performs three operations. First,

Design Grids
Otxri OsSurS
O2u2 O6HKE6
O3Ixn3 OQO7Tu?
O4u 4 O8us

@ Grid Setup

—
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Grid Setu
d The Grid Set-

Measurements in Inches: up dialog box
lets you build

Top Bottom |0.5000 YOUr own Cus-
tom grids.

Inside 0.5000 Dutside |0.5000 Gﬂdjﬂ"?}’be
specified in

' D Column spacing |(0.2500

Row spacing |0.250 olu p q Suches. conti:

Number of columns |2 | Number of rows |4 melers or pi-
cas.

[ Cancel ] |

it selects a basic grid design;
second, it makes the grid visi-
ble; and third, it turns Snap To
on.

To change any grid setting,
click the Grid Setup button then
OK, and the dialog box, shown
above, will appear.

Change the Top, Bottom,
Inside, or Outside numbers to
specily different margins for the
outermost grid lines. Inside re-
fers to the side of the page ncar-
est the center of a two-page
spread — the left-hand side of
an odd-numbered page, the
right-hand side of an even-
numbered page. By making in-
side larger than outside, you al-
low a gutter for binding.

Row and Column spacing
numbers control the distances
between rows and columns.

Number of columns and rows
lets you specify any conceivable
grid combination.

With multiple-page docu-
ments, you'll find it useful to es-
tablish a basic layout on page
one then duplicate that layout
on all following pages.

Note: To avoid accidental
resizing, turn Snap To off
(Special menu) when you create
custom blocks.

Auto page numbering

Start Auto Page Numbering in
the Preferences dialog box lets
you choose a starting page num-
ber for the first document page.

You can specify page num-
bering from any page by holding
down the Command, Option
and Shift keys and pressing 3.
Page numbering can also be spe-
cified on master pages.

Master pages

Use Master Pages o create recur-
ring page elements such as run-
ning heads, page numbers, time
or date stamps, or graphics.
Master pages aclt as a template
for other document pages, so
you don't have to repeat ele-
ments on each page. Select a
master page by clicking on the
L(eft) or R(ight) page icons on
the page scroll bar at the bottom
of the screen. Anything created
on the L page automatically ap-

S o= [[5[]

pears on all left-hand pages (2,
4, 6, etc.). The R master page
stamps all right-hand pages
(1.5.5, &c.).

Creating text and graphics on
master pages is the same as for
normal pages. Master page ele-
ments, however, can only be
viewed on numbered pages, not
edited. To selectively disable the
master page background for a se-
lected page, simply uncheck the
Use Master option from the Spe-
cial menu.



Time/date/page-numbering
Entering Command-Shift-
Option-3 in any master page (ext
block automatically numbers all
pages. Two number signs (##)
mark the page number location
on master pages. These are re-
placed with the actual page num-
bers throughout the document.

To start at a page number oth-
er than 1, choose Start Auto Page
Numbering in Preferences from
the Special menu.

To get a short date (i.e.
10/13/86), press Command-
Option-d. For a long date (Mon-
day, October 13, 1986), enter
Command-Option-Shift-d.

To add the time anywhere in a
document, enter Command-
Option-t.

Adding pages
To add pages to a Ready,Set,Go!

document, choose the Insert
Page(s) dialog box from the Spe-
cial menu:

@ Insert ATter Current Page

{) Insert Before Curreni Page

O Insert Blank Page

@ Duplicate Current Page

From the Insert Pages dialog box
you can create documents of
any size complete with linked
text blocks

Insert Pages lets you add blank
or duplicate pages either before
or after the current page.

Type in the number of pages
you wish to insert — limited only
by your computer's memory ca-
pacity.

If there are linked text blocks
on the current page, you can
choose Duplicate Current Page.
Text blocks on the new page(s)
can be connected in one of three
Ways:

% None: blocks on new pages are

not linked

* Local: blocks on new pages
are linked only with other
blocks on the same page.

* Global: blocks are linked on
the same page and o previ-
ous and subsequent pages.

Deleting pages
Delete Page(s) (Special menu)
brings up this dialog box.

Delete pages dialog box

Type in the page range to de-
lete, from starting page number
to ending page number, and
click OK. If you decide not to
delete pages, click Cancel or
press Enter.

Note: Delete Pages erases
blocks and reflows text through
the remaining chain. Text that is
part of a chain will not be lost, if
any linked block remains.

Selecting pages
You select pages by clicking on a
page number icon on the page
scrollbar at the bottom of the
screen.

To scroll a large number of
pages, use the left and right ar-
rows. The right arrow scrolls

RN

Adding Pages
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numbers to the right, exposing
smaller pages numbers. The left
arrow scrolls the numbers to the
left, exposing larger numbers.

To jump to a particular page,
use the Go to Page # command
from the Special menu.

6o to page #

T
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Viewing pages

Ready,Set,Go! lets you work on a
document page in five different
views. To change to a different
view, choose a size from the Spe-
cial menu:

Size To Fit
Half Size
75% Size
‘Actual Size

Double Size

Text can be edited or objects
moved and resized in any of
these views. If several documents
are open at once, you ¢an view
each document in a different
mode,

Size to Fit reduces the page to
fit the screen. Half Size reduces
the page 50%. 75% Size provides
a slight reduction so you can see
more of the page. Actual Size is
the normal Ready,Set,Go! view.
Double Size magnifies the page
200%. This close-up option is
useful for centering rules between
columns, etc.

Facing pages
Facing Pages (Special menu)
shows the current page and its
facing page in a dialog box.
This view follows publication
folios and shows page 0 and 1,
page 2 and 3, page 4. and 5, elc.
Facing Pages does not allow
text to be edited or objects to be
manipulated.
When you are done, click OK
to return to the last view selected.

Page size

To set paper size and orientation,
select Page Setup from the File
menu. Page Setup displays one of
two dialog boxes, depending on
the printer you have selected.
(You choose the printer with
Chooser from the Apple menu.
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More information on Chooser can be found in
Printout/)

The ImageWriter dialog box displays three spe-
cial effects options. Tall Adjusted changes the as-
pect ratio of the printout to more closely match the
screen. 50% Reduction reproduces the entire page
at half its size. No Gaps Between Pages enables
printing without top and bottom margins.

Imagellriter I
Paper: @ US Letter O R4 Letter EE
O US Legal O International Fanfold E
O Computer Paper
Orientatlion special Effects: []Tall Adjusted
™ [ (] 50 % Reduction
[CINo Gaps Between Pages

R ST Reve SN S

The LaserWriter dialog box offers two Printer Ef-
fects: Font Substitution? and Smoothing? Font Sub-
stitution substitutes the LaserWriter's built-in fonts
for any ImageWriter fonts that are used in the docu-
ment when printing. This speeds up the printing
process, but distorts the spacing between charac-

LaserlWriter 3.1 |
Paper: ® US Letter O R4 Letter Reduce or [F= '
Enlarge: [100]g2

Ous legal O BS Letter

Orientation Printer Effects:

& Font Substitution?
& Smoothing?

ters. For best results, always use LaserWriter fonts in
your documents.

The Smoothing option attempts to smooth out
the graphics. Smoothing takes advantage of the
higher resolution of a printer. It does not, howev-
er, improve the look of all pictures. Digitized pic-
tures often print better with Smoothing off.

Live area

Around the edge of each Ready,Set,Go! page is
dotted line. This rectangle indicates the live area of
the printer you selected in Chooser.

Objects placed outside this rectangle are visible
on the screen, but will not print. The live area of
the LaserWriter printer is slightly smaller than that
of the ImageWriter.

Page Setup should be selected each time you
swilch printers with Chooser. Clicking OK in the
Page Setup dialog box lets Ready,Set, Go! know that
the printer type has changed so that it can change
the live area rectangle on the screen. If you change
printers without going through Page Setup, your
printouts may be shifted to one side, and you may
lose characters to the unprintable area.
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Processing

Ready,Set,Go! offers two ways 1o en-

me ﬂiflty gﬂffy Ofrex[ ter text. Use its built-in word process-

or or import text from other applica-

enr?y andfomaﬁing tions. Before you can enter any text,

you need to create a text block.

To create text blocks, select the
text block tool (see illustration below) from the tool box. When
the text block tool is selected, the pointer arrow turns Into a
crossbar over the document window. Click the mouse where
you want the upper left corner of the text block to begin then
drag the crossbar.

Ready,Set,Go! displays a dotted rectangle to indicate the
border of the new text block, so you can judge its size and shape
as you create it. If you move the pointer past the window bound-
ary while creating a text block, the window scrolls automatical-

ly.

Release the mouse button when the block is the right size. If
a grid is active, your text block will snap to the
nearest grid boundaries.

Once text blocks are created, you can
move or resize them using the pointer tool or
Specifications from the Special menu.

To enter text, select the I-beam tool (see
illustration, right) and click on the text block.
A flashing vertical line marks the insertion
point where text will begin when you type. As Lefi: The tool that creates texi
you type, lines wrap automatically so there is no E;Ir:::;:,{zs Right: The f—ﬂi“ﬁ;n i
need to end each line with a return, Text will fill . ' '
the block and any excess will flow instantly into
linked blocks if any have been created (See Link-
ing Text Blocks).

text editing tool

Importing text
Text blocks may also be filled with text imported from other
documents. Ready,Set,Go! reads documents created by Mac-

Ready,Set,Go! e 29
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Text Editing

Write, Microsolt Word, or any documents saved in
lext (ASCIT) formal,

To import text, select the I-beam from the
tool box, click on the target text block, then trans-
fer the text with Get Text from the File menu:

% Edit Font Style Format

N eLw % N B __ :
Open 30 |— > -
Close 2 Lot g Bea oo is

|: Sape By
E Save as...

N || |7

C Grid Setup

ot Pﬂ_ge SetUp|] 323 g
-1 PIat...

Thi

bet Text
Belt Picture

l]u:t 36[1

Right Insertion pofm created with I—beam
tool in text block. Lefi: Get Text selection

Unless an insertion point or selection range
exists in a text block, Get Text will be dim and una-

vailable. Ak

A Get Text
dialog box ap- s
pears, listing all
reonleny
Word, and text S
files on the active (open )
disk drive. Click | b (Ccames)

through all

drives, folders, and volumes to find the document

that contains the text you want. Double-click on the
file name to transfer the entire contents of the doc-
ument to the target text block. If only a portion of a

document is desired, use the clipboard method de-
scribed below.

Imported text files will assume the format ac-
tive at the point of insertion. MacWrite or Micro-
soft Word text retains all font, style, and size infor-
mation. Other formatting attributes, such as tabs
and indents, must be assigned in Ready,Set,Go!

Clipboard and Scrapbook text

Text can be brought into your Ready,Set,Go! docu-
ments via the Macintosh clipboard. First open the
program document that contains the desired text
and Copy it to the clipboard. Quit the other pro-
gram and open your Ready,Set,Go! document.
Click on the target text block with the I-beam, then
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Paste the text from the clipboard. The clipboard
text begins at the insertion point and automatically
flows into that block.

To avoid switching repeatedly between pro-
grams you can use Ready,Set,Go! with either the
Scrapbook or Switcher. The Scrapbook lets you
copy many text and graphics elements from other
programs and paste them into Ready,Set,Go! all at
once.

Switcher lets you copy text from favorite pro-
grams and instantly switch back to Ready,Set,Go!
for pasting. Make sure that the clipboard’s contents
are transferred when changing to Ready,Set,Go!
This is done by either holding the Option key when
switching programs, or by checking Always Con-
vert Clipboard from the Switcher menu belore ex-
porting.

Text overflow indicator

All text pasted into Ready,Set,Go! will be trans-
ferred to the selected text block, whether it fits or
not. A block that contains overflow text looks as fol-
lows:

& File Edit Farmat

g Uﬂtitl&ﬂg Page | =
Nl acienalastaaiatad st Statalard

Fant  Style Teut Special

.........................

Use the Scrapbook as a place 1© keep

A ils”

i pictares, chary, wXxt, or anything you
| create with Macintosh:

» Keep a letterhead design t© paste into
| your memos
i = Store a distribution list or other fre- i
i ‘quenty used wext ,_J

]iﬁl1lllll—|]|||ll

The text overﬂow indicator indicates more text ex-
ists than is displayed in the block

To view the remaining text either enlarge the
block, reduce text size or link the block to other text
blocks.

Selecting text
With the I-beam you can select text in one of five
ways. Double-clicking on a single word selects that
word and the space that follows. Clicking and drag-
ging selects an arbitrary range.
Another way to select a portion of text is to
Shift-click at the beginning and end of a text range.
To select all the text in a block choose Select
All from the Edit menu. If the block is linked to oth-
er text blocks, Select All will highlight the entire
chain. To select text in one block of a linked chain,
press Option-Select All



Linking Text Blocks

Ready,Set,Go! text blocks are
usually independent objects.

To support articles that span
several columns and even pages,
Ready,Set,Go! lets you link text
blocks together into a single
chain. If text in a linked block is
edited the entire chain is auto-
matically updated.

For example, if you enter text
in the first of two linked blocks,
text overflows automatically into
the second block. If you resize a
text block, Ready,Set,Go! dy-
namically reflows the text to fit
the new block size.

Blocks are
linked using the
linker tool from the
tool box.

To link text
blocks, click the
linker tool on
blocks in the exact
order you want them linked.

If the text blocks are on differ-
ent pages, scroll the pages be-
tween clicks of the linker tool.
When you are finished creating
the chain, select the pointer tool
or double-click on the last text
block to end the linking process.
You can create any number of
linked chains in this manner.

Inserting blocks

To insert new blocks in an exist-
ing chain, use the linker tool to
click on a text block in the exist-
ing chain, then click on one or
more new text blocks. To finish
linking, select the pointer tool or
double-click on the last block
added.

New blocks are inserted in the
chain after the first text block is
clicked. To insert new blocks be-

Linker tool

fore ablock inan -
existing chain,

& File Edit Fom Style format  Tewt Special Fill Pen
| e LIntitled Page | | RS LR e e

hold the Option

phadabeda et te e de b bbb e bededuela

key as you dlick
the linker tool on
the first text
block.

If you paste
linked text blocks
from another
page or docu-
ment, you must
use the linker tool

HEIE RSN IR RN

to relink the text
blocks. If the in-
serted block(s)
belongs to an-
other chain, that
chain reflows itself.

Deleting blocks
There are three ways to delete
blocks chains.

One method is to select the
block(s) with the pointer tool,
then press the Backspace key.
This deletes the block(s) but
leaves text intact, to be reflowed
into any remaining blocks.

The second method uses Cut
from the Edit menu. This de-
letes both the text blocks and
their contents from the chain,
and the rest of the chain relinks
itself. If you've linked blocks A,
B, and C, and cut block B,
blocks A and C remain linked.

Cut copies text blocks to the
clipboard, but all linking infor-
mation is lost. So if you cut three
linked blocks out of a chain,
they are copied to the clipboard
as three independent text
blocks.

Clicking on any linked block
with the linker tool while hold-
ing down the Command key will

Connecting text columns with the linker tool

unlink that block from the chain.

Linking rules

w The lirst click of the linker tool
establishes the start of a chain or
the insertion point inlo an exist-
ing chain, subsequent clicks
create the links. Double-clicking
ends the chain.

* Blocks selected with the point-
er tool, are deleted by Back-
space, but the text remains and is
distributed to other blocks — if
any remain — in the chain. If no
blocks remain, all text is lost.

% Blocks selected with the point-
er tool, are removed completely
from a chain by Cut and copied
o the Clipboard. All linking in-
formation is lost, however.

% Paste does not insert a block
into a chain. Use the linker tool
to link blocks

% A block can only belong to one
chain at a time.

% Command and a click with the
linker tool unlinks a text block
from a chain.
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A selection range forms the basis for all of
Ready,Set,Go!’s text operations
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Deleting text

To delete, select text and
press the Backspace key or
choose Cut from Edit menu

and Clear from the Edit me- Copy I! ®C

(Command-X). Backspace
Paste %l

Clear

nu erase text permanently.
Cut moves text to the clip-
board where it can later be
recovered with Paste. Note,
that in the I-beam mode, Cut deletes text but not

the text block.

Unidn B/

Moving text
To move, select a text range
and choose Cut from the

Copy = (

Command-X to delete the
text from the screen.
Choose a2 new insertion
point, and select Paste from
the Edit menu (Command-
V). Paste retrieves the text
from the clipboard and places it at the new inser-

tion point.

Copying text

To copy, select a text range

[ lear

&* tnip n/
and choose Copy from Edit | = =~~~
menu, or use Command-C. Cut %H

A duplicate of the original
text is placed in the clip-
board.

Paste £ 4l
Clear
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Fonts and styles

Text font, style, and size
attributes are chosen
from the Font and Style
menus. As with other text
attributes, these are as-
signed by selecting a text

Underline
range, then choosing the
appropriate menu op- Olultliiniel

tions. [DEJGI{DIT_TJ

Ready,Set,Go! auto-
matically chooses Gene-
va 12-point as the start-

vPlain 3P
Bold 3B
llelic ¥l

9 Point

up text font. To change to

a new font, select text, [ [..i] E’mﬂﬁlﬁ

then make a selection viZ Peoint

from the Font menu. { € PoinQ
Style and size attrib-

utes are selected from the f [B E’@ﬂmﬁ

24 Peint
36 Point

Other

Style menu. Style choices
include Plain, Bold, Ital-
ic, Underline, Outline,
and Shadow.

In addition to the
standard sizes listed in
the menu, you can spe-
cify any font size from 1
to 127 points by choosing Other, and typing in the
desired point size.

If you establish a new text type (font, size, and
style) before characters are selected, the insertion
point takes on the chosen text type, so any charac-
ters typed from that point on will have the new at-
tributes.

Justifying lines

The commands that control text justification are
found in the Format menu. Text can be arranged
on a line in one of four ways.

Left aligns text flush against the left block mar-
gin leaving a ragged right margin. Right aligns text
lines against the right margin, leaving a ragged left
margin. Center centers text between margins.

Justify fills out each line between left and right
margins so text is set flush left and flush right.

To change justification, select text and choose
the desired arrangement from the Format menu.

If the first character of the line is left, center,
or right justified, the entire line is left, center, or
right justified. Justification can be specified on a
line-by-line basis.

The style menu



Line spacing

Text can also be arranged vertically within a block.
To change line spacing (also relerred to as lead-
ing), select your text and choose Line Spacing from
the Format menu. Type the desired spacing in
points in the dialog box.

Line Spacing 18 points
@ Cancel
The Line Spacing Dialog Box

The value you specify represents the distance
between the base lines of each line of text. To
spread out text, change spacing to a value larger
than the current point size. For example, if you are
using 12-point type, enter 18 to specify one and a
half line spacing.

To return to the initial setting, select the text,
and type auto (in any combination of uppercase or
lowercase letters) and click OK.

Kerning

Spacing between letters is controlled by the defined
width of each character. In certain cases you may
wish to change this spacing on a character-by-
character basis. Ready,Set,Go!, lets you reposition
individual characters, moving them together using
Kern from the Format menu.

A typical situation where a change in character
spacing is warranted is with certain combination of
letters, like AV, that show too much white space be-
tween them. To move the letters AV together, se-
lect both letters, then choose Kern from the For-
mat menu, this will automatically kern these letters

Left: Two letters unkerned. Righi: kerned

based on available pair kerning information.
To manually kern, select the letter V, choose
Kern, and type 3 in the displayed dialog box, and

MR
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click OK. The letter V will moves left three points
(about 3/72 inch).

An alternative — and more visual — method
of kerning involves using the Macintosh Plus key-
board. When text is selected and the Command-
Left Arrow is pressed, letiers will kern by one point.
Repeat these keys to specily more kerning.

Note: If you want to manually kern a range of
text using the dialog box, hold down the Option key
before pulling down the Format menu (o select
Kern, and the dialog box will appear.

Letterspacing

Letterspacing is the exact opposite of kerning:
moving characters apart. In fact, when a characler
has been kerned three points, as in the above ex-
ample, the Leuterspacing dialog box will show -3
points.

To space apart letters, type a value in the Let-
terspacing dialog box or use the Command-Right
Arrow keyboard combination.

Baseline shifts

All text rests on a baseline. The Shift Up and Shift
Down options from the Format menu move char-
acters vertically by a chosen number of points.
These options are opposites and are originally set
al zero. A character shifted up four points will show
as -4 in the Shift Down dialog box.

Baseline shifts can also be performed from
the Macintosh Plus keyboard. Command-Up Ar-
row and Command-Down Arrow move characters
up or down by one point.

Base Line in the Format menu returns charac-
ters to their original vertical position.

Note: All positioning text atiributes are assign-
able to an individual character or a selected range
of characters. If you change positioning when no
characters are selected, the insertion point takes on
the chosen characteristics, so any characters in-
serted at that point will have the newly chosen ai-
tributes.

Paragraph spacing
Paragraph spacing is the amount of space that sets

paragraphs apart from each other. Normally,
spacing between paragraphs is the same as between
lines.

Paragraph spacing is changed by selecting a
range of paragraphs, choosing Paragraph Spacing
from the Format menu, and typing a new value in
the dialog box, followed by clicking OK.

Ready,Set,Go! then adds the point value as
extra space before that paragraph.

Indents
Ready,Set,Go! features three indent options in the
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Format menu: Paragraph Indent, Left Indent, and
Right Indent. Each option displays a simple dialog
box in which indentation can be specified. The
normal setting is zero.

Paragraph Indent de-
termines the first line
indent value from the left- Left
hand border of the text

Right
block. To change the first [:Egntgr
line indent of a para- vJustify
graph, you must include e " e
the first character of the Line Spacing

Paragraph Spacing
Paragraph Indent
Left Indent
Hight Indent

paragraph in your selec-
tion range. If you resize
the text block, the text au-
tomatically adjusts to
maintain the same
indent.

To change the para-
graph indent, type a value in the dialog box and
click OK. Values in the dialog box are in inches,
centimeters, or picas/points, depending on the
Preferences settings.

Left and right indents can be specified in a
similar fashion. Left Indent indents all lines except
the first line of the paragraph (also referrred to as a
hanging indent). Right Indent affects all lines in the
paragraph.

Select a range of characters, choose Left or
Right Indent from the Format menu, then type a
value in the dialog box, and click OK.

Like paragraph indents, left and right indent
values are only used by Ready,Set,Go! if they have
been assigned to the first character of a line.

Find and replace
Ready,Set,Go! can search your text for a particular
word or number and, optionally, replace it with
something else. These functions are found in the
Text menu labeled as Find..., Find Next, and Re-
place...

To find a particular word, type the text in the
Find dialog box. Decide whether the search should

Find what: |CIEETII!
O Block @ Chain [ ok |]

The Find dialog box

cover the current block only or the entire chain by
clicking the appropriate button.

To repeat the search, select Find Next or press
Command-F. Find Next will display the Find... dia-
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log box if no search string has previously been de-
fined.

To replace a text string in your document, use
Replace... from the Text menu. The dialog box will
request your search string and the text you want to
replace it with.

Two additional options — Once and All — let

Find what: Brooklyn
Change to: [San Franciscq
O Block @ Chain
||| @® Once C ANl @

The Replace dialog box specifies a text
string search and replacement

you control the number of replacements.

Note: Any highlighted text will automatically
appear in the Find... and Replace... dialog boxes.
Highlighting a word and pressing Command-F will
immediately locate the next ocurrence of thal
word.

Glossaries
Glossaries let you recall any selection of text with a
single keystroke. To store a frequently used word,
phrase or paragraph in a glossary, select the text
with the I-beam, then choose Glossaries from the
Text menu.

Now, type a single character identification
into the displayed Glossaries dialog box, and click
OK. Ready,Set,Go! stores the selected range of text

and all of its font and
3 Format 'ml Special Fill P
Find...

style attributes in a

glossary associated

with that character. Eﬁ Ut Find Next
wtacl e )l Replace...

Once specified, you
can recall the text
et SHY phenation On
Hyphenation Off

string by pressing
........ Hyphenation Excepti

Command and the

character simultane- —BEEREM i
ously. Tt manifests
i, coupled
Note: Glossary keYs  piversoay o0°
override quiw disinct_Check Spelling

abjects.

‘This conditdon broke out when the work ¢
Yincent van Gorh wvat shown in bulk at th
Brooklyn Museum. [t broke out vhen Do
Armand Hammer pried some French pain
ings outof the Russians and brought them 1
the Unied Enﬂ It broke out 'ﬂun mﬂ:ar

Ready,Set, Go!’s
command key equi-
valents for menu

items. Glossaries are
limited to 46 charac-
ter keys on the main
keyboard. When defin-
ing a glossary, you
need not press the command key.

"Sefecnﬂg | Ie:rtlgfﬁssanef il



Glossaries are saved with each document.
When a documeni is reopened, previously-defined
glossaries that pertain to that document will again
be available.

Deleting Glossaries

To delete a glossary, obtain an insertion point any-
where in your text and select Glossaries. Now you'll
see the following dialog box:

Delete

Glossary character:

Type the letter of the glossary you want to delete
and click OK.

Hyphenation

Ready,Set,Go!'s real-time hyphenation feature au-
tomatically hyphenates words as you type. If you
resize a text block, words rehyphenate instantly.

To turn hyphenation off, select a word or a
range of text, and choose Hyphenation Off from
the Text menu.

A hyphenation exception dictionary lets you
add or remove words that follow specialized hy-
phenation rules. To do this, select Hyphenation
Exceptions from the Text menu, and type the word
with hyphens in the dialog box. If you are done,
click on the Done button.

Click on New Word to add more words to the
dictionary. To edit dictionary entries, click on Pre-
vious Word and Next Word until you find the word
you want and choose Remove Word to delete the
entry. To change hyphenation points, delete the
word and re-enter it as a new word.

The number of exceptions that can be includ-
ed in this dictionary is unlimited.

Discretionary hyphen/Non-breaking space

A discretionary hypen lets you specify that a word
can be broken at a point not ordinarily hyphenat-
ed. These hyphens — entered with Command-
Hyphen — only appear when needed.

A fixed-size, non-breaking space keeps two
words from being split at the end of a line. Hold the
Option key while pressing the spacebar to specify a
non-breaking space.

Spelling checker
Check Spelling, found in the Text menu, can proof
read Ready,Set,Go! documents.

IO

Text Editing

To check your spelling, designate a starting
point by moving the I-beam to the desired location
and clicking. Select Check Spelling from the Text
menu. The spelling checker will immediately load
the file RSG Dictionary into memory. (Note: RSG
Dictionary must be in the same place as
Ready,Set,Go!, i.e. in the same folder)

As soon as the spelling checker finds a mis-
spelled or unknown word it will be highlighted. You
can choose to correct the word by typing over it, or
you can add it to the dictionary by selecting Add
Word from the Text menu, or by pressing
Command-U.

Words added to the dictionary will be placed
in a file called User Dictionary. This is a plain text
file which can be edited with Ready,Set,Go! (see
Put Text below)

To continue spell checking, select Check
Spelling again or press Command-K.

If you would like to check the spelling of single
block in an article, hold down the Option key be-
fore selecting Check Spelling.

Note: Modifying the RSG Dictionary or User
Dictionary file names in any way could disrupt the
spelling checker.

Put Text
You can save any porton
of a Ready,Set,Go! docu-

ment as plain text by se- New &N
lecting the desired text and ﬂpen %0
choosing Put Text from the Cl 1)
File menu. ose

This is a particularly Sapa SN
convenient feature for us-
ers of other text editing Save as...
programs. Put Text lets you Page Setup
export modified text to Print...
your favorite word process-
or for further manipulation Get Text

or file sharing.

You can edit the spell- ‘5 ) PDirtn:
ing checker’s User Diction- bet Pictude
ary using Put Text. Create a text block and select
Get Text from the File menu, then Open the User
Dictionary.

To add an entry, place an insertion point,
type the word and hit Return. To delete a word,
double-click it and hit backspace. After you've add-
ed or subtracted words, use Select All to highlight
the entire file and select Put Text. In the dialog box,
write the file to User Dictionary.

- Note: Never use the spelling checker during a
dictionary update session, as conflicts may arise
between the User Dictionary edited during the ses-
sion and the memory-based User Dictionary mod-
ified by Add Word.
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Cancel

J

The Tabs dialog box controls seltings for nine
tabs. The Measurement in ... message changes
in accordance to the units specified.

Tabs

A Ready,Set,Go! text block can have up to nine dif-
ferent tabs. There are four tab styles available: left,
right, centered, and justified.

To set tabs, make the desired text block active by
clicking on it with the I-beam and select Tabs from
the Text menu.

The above dialog box will be displayed.

Each tab setting has its own On and Off button,
an Indent and Measure field, and four tab style but-
tons: Left, Right, Center and Justified.

To set a tab, first click the On button. In Indent,
enter the desired distance between left margin and
first tab. Measure specifies tab width and provides a
powerful feature: each time your text overflows a
tab, it automatically wraps words to the next line.

If, for example, you would like to set two left-
justified tabs, one beginning half an inch and the
other two and a half inches from the left margin,
you would enter 0.5 in the first Indent field, 1.0 in
the Measure field, and click the L button. Then spe-
cify 2.5 and 1.0 for the second Indent and Measure,
and click OK.

The first time you hit the Tab key, you'll jump to
the 0.5" mark. A second Tab moves you to 2.5".
Pressing Tab again or Return, brings you to the sec-
ond line. The Tab key always moves you to the next
tab stop, depending on your insertion point.

Note: Tabs are properties of an article. It s,
therefore, not possible to vary tab setting by block
in a linked chain.

Also be aware that a linked chain may contain
blocks of differing widths. This may cause some
blocks to have tabs set for a distance grealer than
the block’s width.

(See pages 65 to 68 for additional
information on tabs)
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While other programs can assign character at-
tributes that determine font, style, and size,
Ready,Set,Go! offers the user more advanced
text formatting power.

Ready,Set,Go!’s text attributes also in-
clude justification, line spacing, paragraph
spacing, indents, kerning, baseline shifts, and
hyphenation.

Justification, for example, can determine
whether a line is centered, flush left, flush
right, or left and right justified. Even though
this formatting characteristic affects the entire
line, each character can have its own justifica-
tion value. One line, you might have some
characters set flush right, others set centered,
and others still set flush left.

What determines justification of the entire
line? Ready,Set,Go! looks only to the first
character of each line for justification informa-
tion. Justification attributes of the other char-
acters in the line have no effect on the format.
These attributes are dormant until the charac-
ter happens to be first on a line.

Similarly, if you change Kerning, Letter-
spacing or Shift Up or Down with no characters
selected, the insertion point will assume the
chosen characteristics, and any characters in-
serted at that point will have the new attributes.

The normal setting for all words is hyphen-
ation on. Should you change this attribute by
choosing Hyphenation Off from the Text me-
nu, all words entered from that point on will
not be hyphenated.

Line spacing is determined automatically
by Ready,Set,Go! from the character’s point
size. You can change the standard line spacing
by changing the value of the first character of a
line.

Paragraph spacing, margins and first line
indents attributed to the first character of a
paragraph determine formatting for the entire
paragraph.

This means that when you copy text from
another Ready,Set,Go! page or document it
brings along an entire set of formatting instruc-
tions, which might have to be changed to suit
its new environment




Ready,Set,Go! lets you add
graphic elements to your docu-
ments, lending them a profes-
sional appearance.

T I: Before you can in-
sert pictures on a
E

page, you must create
picture blocks to
house the artwork.
Picture blocks are

Picture tool created with the pic-

ture block tool from the
tool box.

Position the picture block
pointer in the area where you
want to insert the picture, and
drag it across the page to define
the size of your picture block. If
you have an active grid with snap
to on, the block will snap to the
nearest grid boundaries auto-
matically. See Document Design
for information on using grids.

Clipboard pictures
After creating a picture block,
select the cropping tool from the

Picture Perfe

A complete guide to
graphics integration

MM

Graphics

Ready,Set,Go! tool
box.

With the crop-
ping tool click on the
picture block. This
fills the picture block FF—r—
with a background Cropping tool
pattern indicating the picture
block is ready to re-

ceive a graphic. AVAVAVAVAVAVAVAVAVAVAVAVAVAVZ
XN
1. “-,yl

Insert pictures

using the Paste op- 'W WA |||
tion from the Edit Yo X

-

menu. The picture
will be transferred
automatically from
the clipboard into
the picture block,
with the upper left
hand corner of the
picture positioned
at the upper left
hand corner of the picture
block.

If the picture block appears
empty, or if only a portion of the
graphic appears, you may have

.

-
4
i
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to reposition the picture within
the block with the cropping tool.
Click on the block with the crop-
ping tool and drag it around to
bring the picture into view.

To retrieve a picture from the
Scrapbook, pull down the Apple
menu, select the Scrapbook,
choose your picture from the
Scrapbook window and copy it
to the clipboard using Copy
from the Edit menu. Close the
Scrapbook, and Paste the graph-
ics from the clipboard into the
picture block.

Get Picture

Ready,Set,Go! can directly ac-
cess MacPaint, FullPaint, Mac-
Draw (PICT) and MacDraflt
(PICT) files or any other pictures
compatible with these formats.
To import these pictures,
use Get Picture from the
File menu.

(ret Picture
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Get Picture

Quit A

%N E Select a picture block
by clicking on it with the
Open *0 1 cropping tool and choose
! Close W+ Get Picture from the Edit
§ape SHE) menu.
b A dialog box appears,
Save as... |- listing all the MacPaint
Page Setup and PICT documents on
Print the active drive. If neces-
.I'I n+ sary, click the Drive but-
bet Teut ton to locate the picture
ek To> you wish to transfer.
but je:t Double-click on the file

name. The picture imme-

diately appears in the
Ready,Set,Go! picture
block.

Cropping pictures

A picture block acts like a win-
dow through which you view
portions of the picture inside.
To move a picture so that differ-

ent portions are Vvisi-

ble use the cropping
tool.

With the crop-
ping tool click inside
the picture block and
drag the picture until

the desired portion

is visible. The crop-

ping tool does not actually crop
or clip off any of the picture, it
just hides everything that lies
outside the picture block bound-
aries. If you want to see more of
the picture, either resize the pic-
ture block or scale the picture.

Resizing picture blocks

If you find that your artwork
doesn't quite fit the picture
block, you may have to resize
the block. Use the pointer tool
to select the picture block, then

grab one of the
handles along the
outline - of the
block and resize
the block to any
dimension by
dragging the
handles up, down,
or across the
screen.

For more pre-
cise positioning,
you can specify the
exact block size px

and position using
Specifications from the Special
menu. Resizing a picture block
does not stretch or compress the
picture inside the block, it only
changes the size of the viewing
window.

Scaling pictures

Scaling modifies the amount of
picture visible in a picture win-
dow. To scale a picture, select
Specifications from the Special
menu. The Specifications dialog
box presents two scaling values
for picture blocks — Scale

Picture Block Specifications

$tlart Rcross | 1.0000 inches

S$tart Down 1.0000 Inchas

Width 1.0000 inches

bDepth 1.0000 Inches

Scale Across W percent

Scale Down percent

&3 Run Around

The Specifi-
cations dialog
box for pic-
tures blocks
allows accur-
ate percent-
age scaling in
horizontal
and vertical

planes
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Across and Scale Down. These
values let you compress or €x-
pand pictures to fit your layout.
They do not change the size of
the picture block, only the size of
the picture itself.

Graphic objects

You can add lines, rectangles,
ovals, and circles to your pages
using a variety of line types and
widths:

(lines have two handles ) with the
pointer tool. Handles appear
when an object is selected. The

I /II'II

NN NN
\\\\

fllll
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Ready,Set,Go! provides four
graphic object tools: rectangle,
round-cornered rectangle, oval,
and line. To draw an object, se-
lect the desired tool. The point-
er changes to a crossbar in the
document window. Place the
crossbar where you want the cor-
ner of the object. Press the
mouse button and drag the
crossbar diagonally to position
the opposite corner of the ob-
ject. A dotted rectangle indi-
cates the size of the object being
drawn. Release the mouse button
when the object reaches the de-
sired size. If the pointer leaves
the window area, the window
scrolls automatically.

Resizing objects
Objects can be resized by drag-
ging one of the eight handles

top and bottom handles stretch
the object horizontally. Left and
right handles resize the object
vertically. Corner handles
stretch objects in horizontal and
the vertical directions.

Resizing lines

To resize a line, point to one of
the two handles with the pointer
tool, hold down the mouse but-
ton and drag the handle to
shorten or lengthen the line. A
dotted shows the length of the
new line,

Pen widths and styles

Ready,Set,Go! provides a large
assortment of widths and styles
for object borders and lines in
the line patterns box. You can

choose from six solid line
widths, five dashed line widths,
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two scotch rules, and a double
rule. The default line width/style
is a solid narrow line. To change
the width or style of an object
border, select the object with
the pointer tool, and click on
the width or style from the line
pattern box.

Note: Thin produces hairlines
on LaserWriter output only.

Patterns

Ready,Set,Go! features
thirty-nine Fill and Pen
patterns that can be used
for borders and interiors of
graphic objects.

The normal fill pattern
is None (transparent).
When you choose a pattern
from the Fill menu,
Ready,Set,Go! fills the in-
terior of any selected ob-
ject(s) with that pattern. If
no object is selected, the
new pattern becomes the
default pattern for any new
objects until another selec-
tion is made.

L) L] L)
lllllll
. . L}

In addition to line

lllllllllllll

-------------

. styles, the Pen menu ena-
bles you to change pen pat-
terns from black to one of
thirty-eight others. To
change the pattern of an
object’s border, select the

Vil it ddddddddddddiddddidididdddddddd
s(sin/sis/sissssnsissssssassssisasssssssiss
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Running Text
Around Graphics
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One of Ready,Set,Go!'s most powerful features
is the ability to run text around any object. To
make text flow around any object (text, picture,
| line, rectangle, oval or circle), click the Run
| Around check box in Specifications (Special
menu).

All blocks with the Run Around attribute re-
pel text. Therefore, if a run-around object is
placed over a text block, Ready,Set,Go! will re-
format the text to avoid the run-around block.
If the run-around box is not checked, the over-
lapping object will overprint the underlying
text as displayed on screen. Because text fre-
quently flows around graphics, picture blocks
are run arounds by default

Run arounds are also particularly useful
when running text around other text as with
drop caps or large quotations.
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object with the pointer tool and choose a pattern
from the Pen menu. The border will use the select-
ed pattern in addition to any line patterns that you
may have selected from the line pattern box. The
last pen pattern selected becomes the default pat-
tern until another selection is made.
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The moment of g lory

Printers are the most important |
part of your desktop publishing
system.

The Apple ImageWriler pro-
duces output at a resolution of 144
dots-per-inch — well-suited for
inter-office communication,
club newsletters, and rough drafts
of your work.

At 300 dots-per-inch, the Ap-
ple LaserWriter can produce any
type of printed communications.
If you can't afford your own La-
serWriter, check into output ser-
vices that offer laser printouts for
a few dollars a page.

The highest level of printed
quality is achieved with phototy-
pesetters working at resolutions of |
635 to 2540 dots per inch. |

Typesetters compatible with
Ready,Set,Go! are the Allied Li- |
notron 100 (635 and 1270 dpi) |
and the Allied Linotron 300 (635,
1270 and 2540 dpi).

The Macintosh cannot access
printers without the proper soft-
ware. This means that your Sys-
tem Folder should always include
an ImageWriter driver and/or a
LaserWriter driver. Drivers are
computer household programs
that translate documents for
printout.

The LaserWriter driver con-
verts Ready,Set,Go! documents
into a language called PostScript.
Because PostScript is rapidly be-
coming a standard, you can print
on any output device that under-
stands this language. This in-
cludes the LaserWriter, Laser- |

Printing Ready,Set, Go! documents is a rewarding
experience. This article will maximize your enjoy-
ment of the ImageWriter and LaserWriter .

Writer Plus, QMS PS-800, Data- |
products LZR-2662, the Texas In- |
struments Omnilaser, and the
Allied Linotron 100 and 300
typesetters.

The System Folder on the
Ready,Set,Go! System disk
comes pre-installed with Ima-
geWriter and LaserWriter driv-
ers.

If you use a copy of the Sys-
tem disk, you need not worry
about installing printer drivers.
For more information on how to
install drivers, consult your
printer manual,

Selecting printers

The Macintosh lets you alternate
between print-
ers from within

Ready,Set,Go! to adjust the live
area.

(MacServe users should
change printers with the Mac-
Serve desk accessory.)

Choosing fonts
Aside from aesthetic considera-
lions, correct font selection can
improve your printer’s output.
The Ready,Set,Go! System
disk contains a set of fonts for
both ImageWriter and Laser-
Writer. (To install more fonts,
see the sidebar The Font/DA
Mover on page 6.)
The Macintosh uses screen

Ready,Set,Go!

Chooser, a desk
accessory avail- | LE]
able from the
Apple menu,
lets you select

your printer for

fonts in a variety of sizes — typi-
cally 9, 10, 12, 14, 18 and 24
I__.. — El:ln.ni._e}. - - . The C‘I‘DDS‘
%. Select a Laserwriter er desk ac-
D Smrirdtan oo cessory lets
you choose
—— printers
|| from within
S ———— . | [
user name |Michael |2.J gmm

output.

To be able to choose the La-
serWriter, you must connect Ap-
pleTalk via the Control Panel
desk accessory.

After changing printers, se-
lect Page Setup from the File me- |
nu and click OK to allow |

points — to display typefaces on
screen. To see which screen
fonts are installed for each type-
face, pull down the Style menu.
All font sizes indicated in outline
lype are lrue screen fonts.

It is not necessary to have a
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24-point screen font in order to
be able to print 24-point charac-
ters. The Macintosh automati-
cally creates any specified size
by modifying one of the in-
stalled .fonts. Screen fonts, how-
ever, arc much more legible
than scaled fonts:

serWriter fonts by selecting Font
Substitution in the Page Setup di-
alog box. This LaserWriter op-
tion substitutes Times for New
York and Helvetica for Geneva.
Unfortunately, font substitu-
tion produces excessive word
spacing. It is, therefore, recom-

14 point Venice

5b point Venice

A sample of a screen ﬁ:-:-'m (14 pﬂim)_and a scaled font( 36 point)

If you intend to print on the
LaserWriter, use only laser fonts
such as Avant Garde, Helvelica,
Palatino or Times. These fonts
obtain the maximum possible
quality available from the Laser-
Writer.

No matter how rough laser
fonts may look on screen, they
reproduce well on the Laser-
Writer regardless of size. This
due to the fact that LaserWriter
fonts are stored in the printer in
outline form:

7 oo

The outline is used to accur-
ately scale fonts up or down to
produce high-quality fonts in
any point size.

ImageWriter documents

and the LaserWriter

When you print an ImageWriter
document on the LaserWriter,
you can still get the benefit of La-
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mended that you always use laser
fonts for any document you
create, even if it destined for the
ImageWriter.

Printing

To print a Ready,Set,Go! docu-
ment, select the appropriate
window, if necessary, then
choose Print from the File me-
nu. The following Print dialog
box will appear:

LaserlWriter <LaserWriter

EEDIEI:@

Cover Page:

Paper Source: (® Paper Cassetle

The top line of the dialog box
identifies the printer and version
number of the printer driver.

The highlighted field asks
how many document copies you
want to print. Type any number
in this field.

Normally you'll want to print
all pages of a document. To
print a range of pages or a single
page, enter the appropriate
numbers in the From: and To:
fields. (The LaserWriter stacks
printed pages in reverse order in
the receiving tray.)

The Cover Page option lets
you print a cover page at the top

Pages: ® All UFrum:| |Tn:

(Last Page) or bottom (First
Page) of your output stack. The
cover page contains status infor-
mation about the document: us-
er, application, document
name, date, time, and printer.

Paper can either be fed auto-
matically (Pinfeed or Paper Cas-
sette) or manually (Manual
Feed).

The OK and Cancel buttons
let you initiate or cancel print-
ing. The Help button displays a
screen of helpful hints. Printing
can be cancelled at any time by
pressing Command and the Per-
iod () key simultaneously.

Finder printing

If you have several documents to
print, you can print from the
Macintosh desktop (Finder). To
select all the files you want to
print, hold down the Shift key as
you click or drag icons. Make
sure that all icons are
Ready,Set,Go! documents.
Then choose Print from the File
menu Lo start the process.
Ready,Set,Go! is loaded and the
screen displays the Print dialog
box. The print options you
choose will be used for all docu-

@® No O First Page (O Last Page
(O Manual Feed

— The Laser-
= Writer

print dia-

log box

ments. Ready,Set,Go! prints
your documents one at a ume,
then returns to the startup desk-

Lop.

Printing graphics
Graphics come in two varieties:
bit-mapped and object-
oriented. Bit-mapped graphics
are stored as a collection of
dots. MacPaint creates bit-
mapped graphics.
Object-oriented graphics are
stored as a series of commands
that specify objects, such as rec-
tangles, lines, ovals, etc. Mac-
Draw creates object-oriented




graphics.

The distinction is important
because the LaserWriter scales
object-oriented graphics very
well while bit-mapped graphics
are scaled less successfully.

If you want to print graphics
with the highest possible resolu-
tion on a LaserWriter (or type-
setter), create them in programs
such as MacDraw or MacDraft.

To improve bit-mapped im-
ages — use Ready,Set,Go!’s
scaling feature to reproduce the
final image at 25% or 50% its ac-
tual size. Scaling percentages
can be specified in the Specifica-
tions sheet (Special menu).

Quitting Ready,Set,Go!
Before leaving ReadySet,Go!,

first save each open document,
using either Save or Save As...
from the File menu.

Save As... lets you save a new
document or a copy of an exist-
ing one under a different name.

Save is only available for
documents previously saved.
This command lets you save a
file as often as you like with mini-
mal interruption. Save your work
frequently! This prevents catas-
trophic data losses in the event
of any system crashes.

You can also close docu-
ments you have been working on
by clicking on the close box or
using Close from the File menu.
As a safety precaution, a dialog
box will ask whether you want to
save the changes before closing
a document file. To be on the
safe side, always click Yes if you
are not sure.

Quit closes all open
Ready,Set,Go! documents after
displaying the above dialog box
for any unsaved files, and re-
turns to the Macintosh desktop.

Once you have been returned
to the Macintosh Desktop, you
may open other software appli-
cations, or select Shut Down
from the Special menu to eject
all disks and shut off computer
power.

R
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If you often find yourself wishing
you had more fonts to choose
from then just Helvetica or
Times Roman, here's something
for you.

Adobe, the company that
brought you PostScript offers an
entire type library in download-
able form for the LaserWriter or
LaserWriter Plus.

Each package typically con-
tains 4 faces from the same fami-
ly of type (eg. Melior, Melior
Italic, Melior Bold, and Melior
Bold Italic) and costs $185. To
use these typefaces, the typelace
data files must be transferred
from your Macintosh to an allo-
cated space of temporary mem-
ory in your PostScript printer
called virtual memory. Once a
typeface is downloaded, it can
be used as easily as the built-in
typefaces. The typeface package
includes printer fonts for your
printer, screen fonts for your
Macintosh and all of the utility
software required.

To use a downloadable type-
face package, a simple setup
procedure must first be execult-
ed. This procedure includes ini-
tializing typefaces for your Post-
Script printer(s), and moving
screen fonts into your system us-
ing Apple’s Font/DA Mover.

Once printer fonts have been
initialized to a printer or set of
printers, font files can be copied
to as many users of those print-
ers as you like. With your new in-
itialized fonts and screen fonts
moved into your system, you'reé
ready to create your document
with the fonts of your choice.

To produce a document with
these typefaces, select a typeface
from the font menu and create
your document. When you want
to print, select print from the file
menu. By storing the fonts in

Typefaces

---------------------------------

your system folder, they're are
automatically downloaded to
the printer while your job is be-
ing processed. After printing,
downloaded fonts are removed
from your printer frecing mem-
ory for other fonts.

You can also use Adobe's
Font Downloader utility and
manually download fonts your-
self. With this utility, fonts are
downloaded permanently until
you turn the printer off. This
will speed up printing if you use
a certain font frequently.

More than one downloaded
typeface can reside in a Post-
Script printer at a ume; the ac-
tual number depends on the
typefaces and the individual
printer being used. The Laser-
Writer, for example, can hold
two to six typefaces per docu-
ment at one ume, in addition
to the thirteen already built into
every PostScript printer. The
LaserWriter Plus has slightly
more memory for downloada-
ble fonts. With Garamond — a
memory-intensive typeface —
three fonts (Light, Light Italic
and Bold ) can be downloaded
to the LaserWriter Plus keeping
69K of memory for the Laser
Prep.

The Adobe Type Library
currently offers 21 typeface
packages. The newest typeface
families include: Helvetica
Light and Black, Helvetica
Condensed, Trump Mediaeval,
and Melior, each licensed from
Mergenthaler, ITC Galliard,
ITC New Baskerville, ITC Ko-
rinna, each licensed from In-
ternational Typeface Corpora-
tion, Goudy Old Style and Son-
ata are also new.

This magazine was pro-
duced with the downloadable
typeface Garamond.
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Ready,Set,Go! ollers a fascinating way Lo inte-
grate sophisticated graphics in your documents.
In each text Specilications sheet is a simple box
that, when checked, unlocks the full power of the
LaserWriter or any other PostScript device.

To use this feature, enter a PostScript pro-
gram in a standard text block and select the
Specifications sheet from the Special menu.
Click the PostScript option and OK, then
choose print. Instead of interpreting the text
block as regular text, Ready,Set,Go! will send
the instructions directly to the LaserWriter.

If you would like to try this feature on your
LaserWriter, enter the following program in a
text block:

/Times-Italic findfont 30 scalefont setfont
/printRSG

{ 0 0 moveto (Ready,Set,Go!) show} def
320 400 translate

- 95 -.05 0
{setgray printRSG =1 .5 translate} for

1l setgray printRSG

In a minute you will see the words
Ready,Set,Go! printed in a jazzy typestyle:

If your PostScript program does not execute,
check to make sure that you have entered it ex-
actly as shown above. Also see if you checked
the PostScript option in the Specifications
sheet.

Note: This feature only works with LaserWrit-
er driver versions 3.1 and later.

Using PostScript you can achieve such special
effects as rotated type, type made up of radiat-
ing lines, or circular type.

Try this program for radiating type:

/Times-BoldItalic findfont
27 scalefont setfont

/rays

I O 1.5 179

{ gsave

rotate

0 0 moveto 108 0 lineto

stroke

grestore
! for
} def

300 400 translate
.29 setlinewidth
newpath

0 0 moveto
(Starlines) true
charpath clip
newpath

24 =13 translate

rays

This program will produce type with radiat-
ing lines:

Starlines

To learn more about PostScript program-
ming, watch out for future issues of PAGES or re-
fer to PostScript Language Tutorial and Cook-
book published by Addison-Wesley.
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e oonaeiabivking. 2 quzck} overview of
Oul pages seems over- ! g : '
whelming, this article dgszgy/z przyzczp[gg

is for you.

. Although designing
Ready,Set,Go! pages bears some
resemblance to conventional
layout, it requires a fraction of
the time and none of the mess.

To be able to produce eflec-
ive layouts requires a basic un-
derstanding of typography and
the relationship between text
and graphics.

With a little practice and by
following the guidelines present-
ed here, your layout skills should
improve markedly.

Next, decide on the publica-
tion's size. Does it have to be
small enough to [it into a stan-
dard #10 envelope, or is it a full-
fledged magazine?

If your text will be accompa
nied by graphics, select ones
that most coherently amplify
your verbal presentation.

‘The objective of your pub-
lishing project is 1o communi-
cate to the reader in a concise

The first step: planning and effective manner. Embell-
Start by taking a critical look at ishments, such as ﬁf”ﬂ"}" lype or
the content of your publishing dhl:t:[r-'élf*::lu‘llg;{,:l gralplslms,_ rsh{?uld
project. What items are most thereliore be used wiln care.
important to your reader? What

should be emphasized? Organ- Your tone of voice: type

Ascender
Ve
- .
. Point
Baseline
\/ ¥
Descender

Decide which fonts, sizes, and
styles to use for headlines, sub-
heads, captions and body copy.
It's tempting to make liberal
use of the numerous Macintosh

ize articles or items in logical se-
quence, so your thought trend is
clear to the casual reader.

Ready,Set,Go!
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fonts, but this only reduces the
effective-ness of your layout.
Keep it simple. Allow only two
fonts — three maximum per
page.

Before exploring typogra-
phy, let's first define some basic
terminology.

The letters you read right now
are called roman — plain in the
Macintosh world. When letters
are slanted to the right, they are
called ltalic. Fat letters like this
are called bold.

Capital letters are frequently
referred 1o as caps or uppercase,
small letters as lowercase. The
illustration below defines other
parts of letters.

and fonts
Type is divided in families.
Families are groups of type vari-
ations (fonts) with the same
name. The LaserWriter's Times
Roman family includes four var-
iations: plain, italic, bold and
bold/italic.

The Macintosh breaks tradi-
tion by listing each a type family
under a font menu.

The LaserWriler Plus offers
the following typefaces (or
fonts): Avant Garde, Bookman,
Courier, Helvetica, Helvetica
Narrow, Schoolbook, Palatino,
Times Roman and Zapf Chan-
cery. Another font, Zapf Ding-
bats, supplies useful publishing
symbols such as bullets and ar-
TOWS.

Avant Garde and Helvetica
are examples of modern, sans-
serif typefaces. Times Roman is
a classical, serif typeface.

Display type

The beauty of desktop publish-
ing is that it lets you use type in
large point sizes. Designers call

this display type.

Display type (24 points and
up) is very effective for
attention-grabbing headlines,
cover titles, etc.

All caps

When designing pages, remem-
ber that the eye moves along the
upper halves of words.

Since lowercase letters have a
more distinctive upper hallf,
they are usually easier to read to
than all-capital words.

White type

It is more natural to read black

type on white background, so re-

frain from using too much white

type on a black background.
White type is also called re-

verse lype.

Reverse Out

Bold face

Bold faced type should be used
for emphasis only. The same
applies to bold italic.

Italics
Italics give the appearance of
being lighter and more sophisti-
cated than plain type.

This font style is frequently
used for emphasis or to make or-
dinary type seem extraordinary.

Kerning
When you look at text produced
by a phototypesetter you may
notice that letters are closer to-
gether than those generated by
compulters.

This ability to move letters
closer together is called kerning.
Use kerning to tighten up head-



lines and other bodies of display
type. It adds a professional ap-
pearance to type.

Justification

When setting lines that are left
and right justified, avoid making
columns too narrow. This will
decrease your chances of seeing
large, unsightly gaps between
your words (also called rivers).

Drop caps
A large capital letter at the be-
ginning of body copy is called a
drop cap.

Drop caps are designed 1o
lead the reader's eye into the

copy.

White space
Be sure to include plenty of white
space in your layout.

Too much copy and not
enough white space tends to
overwhelm the reader.

Lines

Lines (called rules in design par-
lance) are deceptively powerful
design tools.

Rules can be used to sub-
divide copy, call attention to
certain page elements or simply
for decoration.

Rules come in a variety of
widths:

Hairline (thin in the toolbox)
One point

Two point

——— [ hree point
I [ Our point

I Ve point
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In addition to these lines,

there are dashed l'l.llﬂs, L e————

rules, and double lines.

As with anything in page de-
sign, don't overdo it.

Boxes
Boxes or frames are equally ef-
fective in segmenting text or iso-
lating subjects that require more
attention.

All boxes in Ready,Set,Go!
come in any of the line patterns
discussed under lines.

What-if design

Unlike conventional layout,
desktop publishing makes it un-
necessary to create rough sketch
es, or tissues, of your page be-
fore beginning actual layout.

By using Ready,Set,Go! as
your drawing board, you imme-
diately get to see the results of
any what-if design direction.

Printouts of your layout with
show your progress with great ac
curacy. And a screen preview
mode lets you look at up to two
pages to gauge the effectiveness
of your layout.

Summary

By necessity, this article can on-
ly provide a brief glance at the
world of design and typography.

Refer to the following listing
for books that explore these sub-
jects in greater detail:

Craig, James Designing with
type. Watson-Guptill Publica-
tions, 1980

White, Jan Graphic idea
notebook. Watson-Guptill Publi-
cations, 1980

White, Jan Editing by design.
R.R. Bowker Co., 1982

White, Jan Designing for
magazines. R.R. Bowker Co.,
1982
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How to create outline
& condensed type

Two popular special type effects with type are easy to do
wilth Ready,Set,Go!

Printing white type on a black, or tinted background is
achieved by first creating a text block of outline type and
overlaying it on any object filled with a pattern:

The white type effect can be previewed using the Facing
Pages option from the Special menu. Make sure to send
the tinted background behind the outline type before

printing. |

Distorting type ‘

Another popular effect is to condense (shrink) or extend
(stretch) type.

To do this, create a type in a text block. Format the type
as desired — choosing type style, kerning, etc.— before |
copying the entire text block to the clipboard with the ‘
pointer tool.

Now draw a picture block with the picture tool, and
copy the text block into the picture block. The type will ap-
pear in the picure block.

From the Specifications sheet you can scale the type in
both the horizontal and vertical direction by specifying
any percent in Scale Across and Scale Down.

Normal

Condensed

48 « November 1986




ON THE MENU

n APPLE MENU

About ReadySetGo The Apple Menu lets you access Macintosh desk ac-
cessories from within Ready,Set,Go!

Your Ready,Set,Go! System Disk contains the
Calculator standard desk accessories supplied by Apple. You
can remove or install new desk accessories with the

rrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrr

Lhooser Font/DA Mover (see page 06).

Control Panel

Key Caps About ReadySetGo displays the Ready,Set,Go! ver-
sion number, copyright information, and remain-

Note Pad ing system memory.

Scrapbook

Alarm Clock displays a clock in the upper right cor-
ner of your screen.

Calculator is a handy desktop calculator for simple
calculations involving multiplication, division, ad-
dition, and subtraction.

Chooser lets you select a printer, usually the Image-
Writer or LaserWriter.

Control Panel lets you control various aspects of
the Macintosh interface (speed of double-clicking,
desktop background pattern, etc.). This is also the
place to turn AppleTalk on or off (the LaserWriter
requires that AppleTalk be on).

Key Caps displays a a dialog box with the Macin-
tosh keyboard and a text box. As you press keys, in
conjunction with the Shift, Option, and Shift-
Option keys, the corresponding characters are
displayed in the text box.

Notepad lets you jot down notes.

Scrapbook allows you to store text and graphics for
later insertion into your document. To insert text
copy or graphics from the Scrapbook, select Scrap-
book, click on the scroll bar to display the image
you want to insert, and choose Copy from the Edit
Menu. Close the Scrapbook, click into the block
where you wish to insert using the appropriate (ool
(I-beam for text, Cropping tool for pictures), and
choose Paste from the Edit Menu.
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New AN
Open 30

Close 3Ll
Sape Bkl
Save as...

Page Setup
Print...

Get Texnt
Put Text
belt Pictwre
Quit %0

FILE MENU
New opens a new Ready,Set,Go! document.

Open lets you retrieve an existing Ready,Set,Go!
document. Select the file you want and click Open.
Click Cancel to abort the command.

Close closes the current document. If you have
made changes to the document since the last save,
Ready,Set,Go! will ask whether you want to save the
changes. If you close a new document without sav-
ing, the contents will be lost.

Save saves all changes to the current document. If a
document has not been saved before, Save will be
dimmed. (Use Save as... to save a document the
first time.) A file can be saved as often as you like,
without interrupting work. Save will be dimmed if
no changes have been made to your documents
since the last save operation.

Save as... allows you to save a file under any name.

Page Setup controls paper size and orientation

Print... displays a dialog box for printing option.
After you have made your selections, click OK and
printing begins.

Get Text imports text from a a formatted Microsoft
Word or MacWrite document or a text file. This op-
tion is only available after an insertion point has
been specified. After opening the correct file, text
automatically flows into the selected block. If the
block is part of a linked chain, text will flow into
subsequent blocks as well.

Put Text saves any selected text to an ASCII text file.

Get Picture imports graphics from MacPaint or
PICT format documents. This option is only availa-
ble when a picture block has been selected with the
Cropping tool. Get Picture displays a dialog box
showing available picture files. Choose the desired
picture and click Open.

Quit closes all open documents and exits from
Ready,Set,Go! to the startup desktop.



ndo

Cut

Copy
Paste
Clear

w

Select All

Chicago
vbGeneva
Helvetica
Monaco

Times

#A

AR

On The Menu

EDIT MENU

Cut removes selected text or objects from a page.
The cut items are copied to the clipboard, and can
be recalled using the Paste option (as long as no
other Cut or Copy action take a place in the mean-
time).

Copy copies selected items to the clipboard, leav-
ing the originals intact. Copied items can later be
Pasted into the page.

Paste places copies of Cut or Copied text or objects
in the current page.

Clear erases selected text permanently.

Select All lets you select all page objects (at the
Pointer level) or text in a text block or chain of
blocks (at the I-beam level). If you hold the Option
key down while choosing Select All, only the cur-
rent text block will be selected.

FONT MENU

The Font menu lets you select fonts and is available
when working with text

The Ready,Set,Go! System Disk comes installed
with Chicago, Geneva, Helvetica, Monaco, and
Times. Other fonts can be installed with the Font/
DA Mover (see page 6).

The default font upon startup is Geneva. To
choose another font, select a range of text, and se-
lect the desired font from the Font Menu.
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vPlain P
Bold 3B
/telic |
Underline

oultilliine!
Shadom

9 Point

10 Peint
viZ Point
14 Point
18 Peolnt

24} Point
36 Point

Other

STYLE MENU

The Style menu lets you choose the style and size of
text characters. Style choices include Plain, Bold,
Italic, Underline, Outline, and Shadow.

The Style menu is disabled when the I-beam is
not selected.

Plain, Bold, etc. To choose a new font style, sclecl
a range of text and choose the desired style from
the Style menu.

9 Point, 10 Point, etc. Ready,Set,Go! displays the
installed screen sizes of the selected font in outline
style. Standard screen fonts include 9, 10, 12, 14,

18, and 24.

Other lets you specify any font size between 1 and
127 points in one-point increments.
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On The Menu

FORMAT MENU

Left justifies text flush left with a ragged right mar-
gin.

Right justifies text flush right with a ragged left mar-
gin.

Center centers text in a text block.

Justify justifies text flush left and right.

Line Spacing lets you change spacing between lines
in point increments. To change line spacing, enter
any point size in the dialog box. To return to auto-

matic line spacing enter auto in the dialog box.

Paragraph Spacing controls spacing between para-
graphs. The default spacing is zero ( i.e. the same
between paragraphs as between lines of texu.

Paragraph Indent controls the first line indent of a
paragraph.

Left Indent indents all lines of a paragraph except
the first one. This is also called a hanging indent.

Right Indent indents all lines from the right mar-
gin.

Kern automatically kerns a selection range accord-
ing to available kerning pairs. Holding the Option
key before selecting Kern lets you specify the
amount of kerning in points.

Letterspace spaces characters apart in point incre-
ments.

Shift Up moves characters up line in point incre-
ments.

Shift Down moves characters down in point incre-
ments.

Baseline returns a character to the original baseline
position.
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vHyphenation On

TEXT MENU

Find... searches text for a particular word. To find a
word, select a starting point with the I-beam, type
the word in the Find What dialog box, choose
Block or Chain option, and click OK to initiate the
search.

Find Next causes the search to continue through the
remaining text, and highlights each occurrence of
the word(s).

Replace... displays a dialog box requesting search
word(s) and replacement word(s).

Hyphenation On toggles hyphenation on. Hy-
phenation on is the default Ready,Set,Go! mode.

Hyphenation Off turns off automatic hyphenation.
To turn hyphenation off, select the text you choose
not to hyphenate, and toggle this option.

Hyphenation Exceptions lets you to add exceptions
to the hyphenation dictionary.

Glossaries store often-used text for instant recall us-
ing a Command-key sequence.

To define a glossary, select a range of text, and
choose Glossaries. Type a single character in the
displayed dialog box, then click OK. To recall the
glossary, press the Command key and the refer-
ence key simultaneously.

Tabs lets you specify tabs for a text block or chain.

Check Spelling will proof your copy against the RSG
Dictionary beginning from the insertion point.

Add Word will add any highlighted word to the Us-
er Dictionary for future spell checking reference.



Size To Fit ®1
Half Size 82
75% Size %3

vActual Size 49
Double Size #€5

Insert Page(s)
Delete Page(s)
Go to Page #

----------------------

Preferences

Snap To
vise Master

Design Grids €D
Alignment
Specifications 3*M
Bring To Front

Send Behind

AR

On The Menu

SPECIAL MENU
Size To Fit lets you view an entire page on screen.

Half Size reduces everything to half size so more of
the page is visible.

75% Size reduces the page to 3/4 size, fitting the en-
tire width of a page in the window.

Actual Size is the normal Ready,Set,Go! view.
Double Size enlarges the page 200%.

Insert Page(s) adds pages to a Ready,Set,Go! docu-
ment. The dialog box lets you insert blank or dupli-
cate pages before or after the current page.

Delete Page(s) deletes pages from the current doc-
ument.

Go to Page # lets you go directly to a specific page.

Facing Pages shows the current page and its facing
page. When finished viewing, click OK to return to
the last view selected.

Preferences allows you to control measurement
units, to show or hide rulers and grids, and the start
number of automatic page numbering.

Snap To toggles the snap-to features of a grid on or
off. It is checked when it is on.

Use Master turns the master pages background on
or off. It is checked when it is on.

Design Grids lets you specify grid parameters.

Alignment aligns multiple objects. This command
is only available when more than one object is se-
lected.

Specifications is used to change certain attributes of
objects including size, position, runaround status,
and for text blocks, PostScript or normal.

Bring To Front brings a selected object to the front.

Send Behind sends objects behind.
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FILL MENU

The Fill Menu provides thirty-nine patterns that
can be used used to fill rectangles, round-cornered
- rectangles and ovals. The default pattern is None
L (i.e.transparent).

S When you choose a pattern from the Fill Menu,
Ready,Set,Go! fills the selected object(s) with that
pattern.

AP 292020 If no object is selected, the new pattern be-

- comes the default pattern for any new objects until
S ah b another selection is made.
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D o PEN MENU

The Pen Menu enables you to change the pen pat-
tern of lines or object borders from black to one of
thirty-eight other patterns.

To change a pattern, select the object with the

':'..1-".1-:-
YA Pointer tool and choose a pattern from the Pen
menu. The object changes to the selected patiern.
L P The last line pen pattern selected becomes the
KN 0. 9.9. default pattern when new objects are created until
Y another selection is made.
et
Y.,
oo
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GLOSSARY

Acetate — an overlay used by
graphic artists to indicate a dif-
ferent color or element.
Ready,Set,Go! lets you copy
certain elements to a different
document window so they may
be printed seperately and used
as an overlay.

Baseline — the reference point
used for the vertical alignment
of characters. Normally, it is
the line crossing the bottom-
most part of a character.

strokes used for emphasis or vis-
ual effect.

Camera ready — pages com-
plete with text and graphics that
are ready to be printed.

Caps — short for capital letters.

Column — refers to a vertical
section of text in a layout.

Crop — 1o select a part of a
graphic image by reducing the
live im-

age area.

OGO

Baseline

Colhumn
rule —a
vertical
. line,
used to

separate

Bitmap font — a set of charac-
ters created by turning individu-
al dots on or off. The Macintosh
screen fonts are often referred to
as bitmaps. Also, when the La-
serWriter does not find a down-
loadable font used in your docu-
ment in ROM it will automatical-
ly print a bitmap font.

Body copy — the main text of
your document.

Boilerplate — text that is used
over and over without change,
such as an address or even whole
sections of text. Use Glossaries
from the Special menu to store
boilerplate text.

Boldface — a type style with

thicker or more pronounced

text col-
umns.

Comp — short for comprehen-
sive layout, a complete sketch of
a page layout. Ready,Set,Go!
lets you create comps with much
more precision and detail.

Condensed — refers to a type
style that is narrower than the
normal character width. You
can produce this effect by scal-
ing type in a picture block.

Copyfitting — literally: trying to
make copy fit the layout. With
Ready,Set,Go!"s built-in word
processor you can edit an article
to fit any layout or vice versa.

Dialog box — a box where you
make choices or provide infor-
mation needed to perform a
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GLOSSARY

task.
Digitizer — (see scanner)

Discretionary hyphen — an op-
tonal hyphen that separates
parts of words, but is invisible
until needed. To insert a discre-
tionary hyphen, press the Com-
mand and hyphen keys.

Descender — the part of a letter
that extends below the baseline
like ina g.

Field — the entry area in a dia-
log box that asks for specific in-
formation.

Find — To look for specific oc-
currence of text in a document
using the Find command.

Flush — referred to formatting
text to the right or left margin.

Font — a complete set of char-
acters in one typeface and size.
Since the Macintosh can derive
italic and bold, etc. from a sin-
gle set of characters, it has come
to mean typeface family as well.

Footers — see Running heads.
Global search — See Find.

Glossary — A feature that stores
text and later retrieves it by
holding down Command and
another key. Also see Boiler-
plate.

Gutter margin — the inner mar-
gins of facing pages of a docu-

menl: the left side of odd pages
and the right side of even pages.

Use the Design Grids to specify
these margins to be wider allow-
ing extra space [or binding.

Hé& J — an abbreviation of hy-
phenation and justification, the
process of adding spaces and
hypens to make words fit in a
flush right and left line.

Hairline — the thinnest line re-
producible by the LaserWriter,
about one quarter point. In the
Ready,Set,Go! line pattern box
it is indicated as Thin.

Halftone — a picture that con-
tains shades of grey created with
differing combinations of dot
patierns.

Hanging indent — an indent of
the first line that is less than the
indent of subsequent lines, so
that the first line of a paragraph
is wider than the rest of the lines.
Use Left Indent to create hanging
indents.

Hard hyphen — a hyphen,
created with the hyphen key on-
ly, that is shown whether it falls
in the middle of a line or at a
line end. Also see Discretionary

hypen.

Headers — see Running heads.

Insertion point — a blinking ver-
tical bar indicating where text
will be inserted into a document

as you type.

Justify — to align text along a
margin. Typeset material is of-
ten justified along both the right
and left margins, achieved by



adding extra space between
words as necessary.

Kerning — refers to the process
of decreasing the space between
letters.

Layout — the arrangement of the
text and graphics elements on a

page.

Leading — also known as line
spacing, the process of adding
space between lines of type to
provide additional space. Lead-
ing is specified in points with
each point being approximately
1/72 inch.

Letterspacing — the addition of
space between letters within
words in a line in order to make
the line come out to a desired
length.

Ligature — the actual connec-
tion of two letters.
Ready,Set,Go! can produce lig-
atures by kerning letters very
tightly.

Line art — pictures containing
only blacks or whites (see also
Halftone).

Line spacing — the amount of
space between lines of text with-
in a selection range or entire ar-
ticle. Also see Leading.

Live area — the part of a page
available for printing. The
LaserWriter is unable to print
completely to the page edge,
leaving an unprintable area
measuring 0.45 inches on each
side.

GLOSSARY

Margin — the area from the left
of the page to the edge of text.
To set margins accurately, use
the Specifications sheet from the
Special menu for any text block.

Mechanical — the complete lay-
out with text and images ready
for printing. Ready,Set,Go!
creates camera-ready materials
directly from the LaserWriter.

Monospace — refers to type
where each character takes up
the same amount of space. The
LaserWriter has one monospace

character set: Courier.

Page makeup — the process of
combining text and graphic ele-
ments to create a finished,
publishable page.

Permanent font — a download-
ed font that remains in the
LaserWriter until the power is
turned off or the printer is reset.

Pica — a typsetting measure
equal to 1/6 inch, or 6 picas to
an inch.

Point — a measure of size used
in typesetling: one point equals
1/12 of a pica and approximate-
ly 1/72 of an inch. Used to des-
ignate the size of type. Ten point
is the size you are reading now,
48 point is a typical headline size
and 6 to 8 point is fine print.

PostScript - Adobe’s page
descrption language that com-
municates text and graphics in-
formation between a computer
and an output device.
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GLOSSARY

Proportional characters — a
character design where each
character has its own character
width. Proportional characters
reduce the amount of space re-
quired for print and are easier to
read than constant width or
monospaced fonts.

Quad — to align a block of type
to the center, left, right or justi-

fied.

Ragged — text with an uneven
left (ragged left) or right (ragged
right) edge. Also see Justify.

Running head — Text or graph-
ics that appear at the top
(header) or bottom (footer) of
printed pages. Running heads
can include page numbers,
dates, time, titles, or other text
and graphics. Ready,Set,Go!
lets you create running heads
with the master page feature.

Scanner — a hardware device
that converts text or graphics
into digital information that can
be read, stored and manipulat-
ed by a computer,

Selection range — a highlighted
character or group of characters
that will be affected by the next
command.

Serif — a small cross stroke or
ornament at the end of a letter’s
main strokes. An example of
serif type is Times Roman. Hel-
vetica is a sans serif (without ser-
if) typeface.

Transient font — a download-
able font which remains in the

LaserWriter’s memory until the
document is finished printing.

Typeface — a family of fonts that
share similar charactistics, such
as serifs, etc. Times Roman is a
typeface. Times Roman Bold is
one font.

White space — the unprinted
space in a page layout. The
amount of white space greatly af-
fects a document’s readability
and aestheucs.

Wordwrap — the automatic
shifting of a word to the next line
when you enter text and reach
the right margin. Ready,Set,Go!
checks to see if the word you type
fits completely on the line. If
not, Ready,Set,Go! will hyphen-
ate or wrap the entire word to the
next line.

WYSIWYG — (pronounced wiz-
zywig) an abbreviation for What
You See Is What You Get, refer-
ring to the feature that what you

see on screen is what will be re-

produced by a computer print-

er.

X-height — the size of a small
letter like x, which is also usually
the height of the main body of
characters.

Zapf Dingbats — a font compri-
sed of bullets, stars, arrows and
other symbols. The Dingbats
font is included with the Laser-
Writer Plus.
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A Guide To Tabs and Indents
in Ready,Set,Go! 3:

TABS

1. Each article in a RSG3 document can have a set of up to nine tabs attached to it. An article is
defined as a linked set of text blocks which may span multiple pages. An independent text block
is a simple example of an article.

2. In RSG3 tabs should be thought of as “mini-lines’’ or as “lines within lines.”” As such, each tab
column is defined by an INDENT from the left margin of the text block and a MEASURE, or
width, for this particular tab column. Within a particular tab column text may cither be left
aligned, right aligned, centered, or justified.

3. If no measure is assigned to a tab column, RSG3 will automatically define the measure to be the
distance between the indent of the tab column and the current right margin of the text block
(adjusted for cut-outs and right indents) in which tab is being used.

4. If no alignment (L, R, C or J) is given to a tab column, RSG3 fills in an L by default.
5. TAB COLUMNS MAY OVERLAP.

6. To set up tabs, use the I-beam tool to get a blinking insertion point in any text block in the article
you ar¢ working on. Choose Tabs from the Text Menu. A large dialog will appear. Fill in as many
tab fields as vou need and turn them on. The only field that must be entered is the INDENT
field. As noted above both the MEASURE field and the L.R.C or ] choice are optional.

7. Since an article may span multiple text blocks which may be of different widths, it is possible
that one or more tab columns which fit in a particular text block in an article do not fit in a
different text block in the same article. When this happens, i.e., when the indent (or the sum of
the indent and measure if one is supplied) exceeds the width of a particular text block, RSG3
temporarily turns the tab “off.”

8. When you are working in a tab column and your text overflows the column, it will automatically
wrap to the next line and stay within the tab column. If you hit the tab key again you will jump
to the next available tab column on the current line (if any is available), or the first tab column
on the next line. A return will bring you back to the left margin of the text block and to the next
line.

9. If you do not set any tabs and hit the tab key, a fixed space of eight points will be inserted in the
text.

10. Since RSG3 handles tabs differently from other programs (even carlier versions of RSG), tab

settings cannot be imported. The tab keystrokes within the text stream are imported but the tab
columns must be reset within RSG3.

11. Some examples:
First consider a simple 4 column table of numbers:

Create a text block 4" wide, choose 12 point Times and set 4 tabs:

Tab 1: Indent = 0 Measure = .5 Left
Tab 2: Indent = 1 Measure = .5 Right
Tabh 3: Indent = 2 Measure = .5 Right
Tab 4: Indent = 3 Measure = .5 Right

Tabs & Indents
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Text :

(TAB) Hat (TAB)S$1.95(TAB)$2.95(TAB) $3.95 (RETURN)

(TAB)Pants (TAB) 1.86(TAB) 2.86(TAB) 3.86 (RETURN)
(TAB) Shirt (TAB) 1.42(TAB) 2.42(TAB) 3.42 (RETURN)
(TAB) Shoes (TAB) 1.71(TAB) 2.71(TAB) 3.71 (RETURN)

Hat $1.95 $2.95 $3.95
Pants 1.86 2.86 3.86
Shirt 1.42 2.42 3.42
Shoes 1.71 A il

Next consider some indented copy:

Create a text block 4" wide, choose 12 point Helvetica and set a single
tab:

Tab 1: Indent .2"; LEAVE THE MEASURE FIELD AND BUTTONS BLANK.

I

TeEr

Option-7 (TAB)Now is the time for all good men to come to the aid of their
country. The quick brown fox jumped over the lazy dog. Now is the time
for all good men to come to the aid of their country. (RETURN)

Option-7 (TAB)Now is the time for all good men to come to the aid of their
country. The quick brown fox jumped over the lazy dog. Now is the time
for all good men to come to the aid of their country. (RETURN)

Option-7 (TAB)Now is the time for all good men to come to the aid of their
country. The quick brown fox jumped over the lazy dog. Now is the time
for all good men to come to the aid of their country. (RETURN)

! Now is the time for all good men to come to the aid
of their country. The quick brown fox jumped over
the lazy dog. Now is the time for all good men to
come to the aid of their country.

! Now is the time for all good men to come to the aid
of their country. The quick brown fox jumped over
the lazy dog. Now is the time for all good men to
come to the aid of their country.

¢ Now is the time for all good men to come to the aid
of their country. The quick brown fox jumped over
the lazy dog. Now is the time for all good men to
come to the aid of their country.

Notice that in this example only the indent was set. Ready,Set,Go! 3 set the measure and left
alignment automatically. Also notice that the entire text word wrapped within the tab column.

Tabs & Indents
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Next consider a multi-indented outline:

Create a text block 6" wide, choose 12 point Times, and set 4 tabs:

I

25 LEAVE MEASURE BLANK; Justified;
Tab 2: Indent . 50 LEAVE MEASURE BLANK; Justified;
Tab 3: Indent P S LEAVE MEASURE BLANK; Justified;
Tab 4: Indent = 1.00 LEAVE MEASURE BLANK; Justified;

Tab 1: Indent

I

TeXt :

(TAB)I. (TAB)This is an example of an outline. (RETURN)

(TAR) (TAB)A. (TABR) This outline is being produced with Ready,Set,Go! 3. Now
is the time for all good men to come to the aid of their country. This
outline is being produced with Ready,Set,Go! 3. Now is the time for all
good men to come to the aid of their country.This outline is being
produced with Ready,Set,Go! 3. Now is the time for all good men to come
to the aid of their country. (RETURN)

(TAB) (TAB) (TAB) 1. (TAB) This outline is being produced with Ready, Set,Go!
3. Now is the time for all good men to come to the aid of their country.
This outline is being produced with Ready,Set,Go! 3. Now is the time for
all good men to come to the aid of their country.This outline is being
produced with Ready,Set,Go! 3. Now is the time for all good men to come
to the aid of their country. (RETURN)

(TAB) (TAB)B. (TAB) This outline is being produced with Ready,Set,Go! 3. Now
is the time for all good men to come to the aid of their country. This
outline is being produced with Ready,Set,Go! 3. Now is the time for all
good men to come to the aid of their country.This outline is being
produced with Ready,Set,Go! 3. Now is the time for all good men to come
to the aid of their country. (RETURN)

I. This is an example of an outline.

A. This outline is being produced with Ready,Set,Go! 3. Now is the time for all
good men to come to the aid of their country. This outline is being produced
with Ready,Set,Go! 3. Now is the time for all good men to come to the aid of
their country.This outline is being produced with Ready,Set,Go! 3. Now is the
time for all good men to come to the aid of their country.

1. This outline is being produced with Ready,Set,Go! 3. Now is the time for
all good men to come to the aid of their country. This outline is being pro-
duced with Ready,Set,Go! 3. Now is the time for all good men to come to
the aid of their country.This outline is being produced with Ready,Set,Go!
3. Now is the time for all good men to come to the aid of their country.

B. This outline is being produced with Ready,Set,Go! 3. Now is the time for all
good men to come to the aid of their country. This outline is being produced
with Ready,Set,Go! 3. Now is the time for all good men to come to the aid of
their country.This outline is being produced with Ready,Set,Go! 3. Now is the
time for all good men to come to the aid of their country.
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INDENTS

With Ready,Set,Go! 3, paragraph indent, left indent and right indent may be used instead of tabs to
solve a wide range of formatting problems. The essential point to remember is that indents are
attached to a selection range so that different paragraphs in the same text block or article can have
different indents. Paragraph indent refers to the indent of the first line of a paragraph from the left
margin of the text block. Left indent refers to the indent of every line of the paragraph except the
first line from the left margin of the text block. Right indent refers to the indent of every line of the
paragraph from the right margin of the text block.

The following paragraphs were created in 12 point helvetica in a text block of width 4”. The format-
ting properties assigned to each paragraph are noted in the margin.

Exhibitionitis, though benign, is contagious. It

e manifests itself in a general state of euphoria,
Right=0" coupled with the attribution of magical powers to a

visiting anthology of works of art quite distinct from
the intrinsic quality of the objects.

This condition broke out when the work of Vincent
van Gogh was shown in bulk at the Brooklyn
Museum. It broke out when Dr. Armand
Hammer pried some French paintings out of
the Russians and brought them to the United
States. It broke out when unicorn met unicorn  "7*7%_
at the recent show of European tapestries at .. e
the Met. It broke out when the treasures of
Tutenkhamun were shown in London, and it is
breaking out right now in Toronto. If the
Chinese exhibition makes it to the National
Gallery in Washington—and a date in
December has been penciled, though not yet
confirmed—we can be quite sure that it will
break out there too.

The Chinese exhibition was a great success in
London (more than 750,000 visitors, thanks in
part to a truly demonic propaganda machine);
and it was warmly received in Paris, Vienna

i;::: and Stockholm. China is still a place of

Right= o> mystery to most of us, and there s
undeneiably a paricular white magic about a
very beautiful object that has been buried
beneath the ground for 2,000 years or so.
There are many such objects in the Chinese
exhibition; and they have a pristine,
unscrutinized quality. We feel that they have
been put there for us and no one else.

Tabs & Indents
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The Authoritative
New Magazine
From the Publishers
Of PC World and
Macworld

Publish!

The How-to Magazine of Desktop Publishing

If you use a Macintosh or PC

system to publish reports, news-

letters, books, ads, brochures, or
any other printed material, then
you need Publish!, the How-to
Magazine of Desktop
Publishing.

Act Now
for Charter
Subscriber
Savings—
33% Off!

Publish! is a new magazine
that is written, edited, and
produced on personal
computer-based systems.
Because Publish! is on the
cutting edge of this exciting
new technology, you can
depend on us for the expert
information you need to set
up and manage your own
personal publishing
operation.

Each colorful, feature-filled
issue is easy to read and
understand, yet compre-
hensive and authoritative.
Publish! will answer all your
questions about how to use
personal computers with
laser printers and page
makeup software—and even
how to drive commercial
typesetters with a personal
computer. What’s more,
Publish! covers both stand-
alone systems and networks.

Publish! shows you the short-
cuts and tricks of the trade
that can help you get the
most from the hardware and
software available. You'll
learn fundamentals of
graphic design and other
publishing basics, and you'll
save time and money, too.

In coming issues
of Publish!...

e Getting the manufacturer
support you need

e Advice on designing your
pages for maximum impact

e Major New York graphic
designers discover desktop
publishing

e Cost-saving ways to
prepare pages for
outside printing

e Hardware and software
revVIEws

¢ Hundreds of new product

listings

All this and more comes to
you in Publish!, six times a
year—and at a low Charter
Subscriber price if you act
now.

Fast action
saves you money!

For a limited time, Charter
Subscriptions are available
for just $19.95 for a full year
(six bimonthly issues). You
save 33% off the basic sub-
scription price others will
pay when the Charter offer
closes.

Take advantage of this
limited-time Charter Sub-
scriber offer now and get the

full benefit of Publish!'s ex-
pertise as soon as possible.

Be a
Charter

Subscriber
and SAVE!

Be sure to use the convenient
postpaid order card in the
pocket of your ReadySetGo

Software Package.

or call TOLL-FREE
800/222-2990

VISA and MasterCard accepted.
Publish!
Subscription Department

P.O. Box 51966
Boulder, Colorado 80321-1966

Guanantee: If you're ever dissotisfied with Publish!,
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